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1.0. Introduction 
This in-house style guide was created to make the Resource and Patient Management 
System (RPMS) documentation produced at the Indian Health Service (IHS) Office 
of Information Technology (OIT) more consistent over time. While this document 
will take precedence over external and general style guides, it is by no means the 
authority on documentation requirements. The RPMS Programming Standards and 
Conventions

This style manual is based primarily on a combination of: 

 (SAC) is the final authority on formal, high-level documentation policy. 

• Internal documentation needs 

• Appendix F of the 

• 

RPMS Programming Standards and Conventions 

• 

The Chicago Manual of Style (15th edition) 

If an issue is not addressed in this internal style guide, please consult The Chicago 
Manual of Style (15th Edition) or the Merriam Webster Collegiate Dictionary (most 
recent edition). 

Microsoft Manual of Style for Technical Publications (3rd edition) 

Because the Internet is also a convenient and cost-effective tool, the following 
resources can be consulted when further clarification is necessary: 

• The Merriam Webster Online Dictionary: http://www.m-w.com/dictionary.htm 

• Webopedia, an online dictionary and search engine for computer and Internet 
technology definitions: http://www.pcwebopedia.com/ 

When an issue is not addressed in this style guide and there is a disagreement 
between these online sources and the paper sources listed above, the paper source will 
overrule the online source. 

The terminology and instructions in this manual reflect the layout and menus of 
Microsoft Office 2007. Readers with older versions of Microsoft Office will need to 
adapt the instructions presented in this manual to their own applications. 

For questions about the material in this style guide, contact the OIT Documentation 
Team (IHS Documentation Team@ihs.gov). 

http://www.m-w.com/dictionary.htm�
http://www.pcwebopedia.com/�


OIT Standards and Conventions v2.0 

Documentation Style Guide Usability Guidelines 
November 2010 

2 

2.0. Usability Guidelines 

2.1 Eliminate Superfluous Information 
Superfluous information creates the following usability issues: 

• Increases the amount of text that a reader has to understand 

• Increases the time and effort the reader invests to access information 

• Takes up space in the reader’s short-term memory 

• Drains the reader’s mental resources 

Superfluous information includes the following: 

• Unnecessary adjectives and adverbs 

• Information about irrelevant topics 

• Personal opinions and humor 

• Speculation about future product functions 

• Rhetorical questions 

2.2 Create Consistent Structures 
Create documents with repeated structures when possible, using the same hierarchy of 
sections and the same categories of information in each section. When the hierarchy 
and structure of the information are repeated throughout the document, users become 
accustomed to looking for certain types of information in certain places, reducing 
their uncertainty when approaching documentation. 

The structure of a document is like a street map. A street map that is consistent across 
an entire region is a better navigation tool than one that is inconsistent. 

The intrinsic repeated structure of a document needs to be orderly, logical, and 
consistent. If the document is an overview, make sure that all topics are covered at the 
same level of detail. If the document provides detailed, step-by-step instructions for 
using a particular function, ensure that (1) similarly detailed instructions for all 
functions are also given, or (2) that a logical explanation for the discrepancy is 
provided (for example, detailed procedures are only included in the overview or 
reference guide for new functions). 

2.3 Use Modular Information Blocks 
Most readers are searching for a specific piece of information. They do not read 
technical documentation for enjoyment. 
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To meet the reader’s information requirements, create modular blocks of relevant 
information about specific topics. Modular information is easier to understand and to 
update than long passages of unstructured materials. 

Typically, a modular block of information is a stand-alone entity that contains the 
following information elements. 

• Heading.

• 

 Make headings expressive. Tell the reader what to expect from a 
specific type of section or module. When the reader encounters a similar heading, 
the type of content is already familiar.  

Textual Information.

• 

 Break textual information into discrete submodules of 
related information grouped into separate paragraphs. 

Integrated Supporting Elements

If each documentation module conveys the correct information to the reader, then the 
reader performs the correct action. Inconsistent documentation modules can confuse 
the reader. 

. Information elements that support textual 
information can include lists, procedures, tables, and graphics. 

Create modules short enough to keep scrolling or page turning to an absolute 
minimum. 

2.4 Use Consistent Language 
Creative writing teachers tell us to vary our writing style and vocabulary to hold the 
reader’s interest, but technical documentation requires the opposite: using the same 
vocabulary for the same purpose throughout a document or set of documentation. 
When a team of writers is working together, they must work to achieve a single voice. 

Repeated use of consistent language builds long-term memory and reduces the 
demand on short-term memory, allowing the reader to concentrate on the information 
rather than waste time and mental energy figuring out what is being discussed. 

Other language points to consider: 

• Words with Latin or Greek roots are harder to understand than equivalent English 
words. (Exceptions are standard Latin-based terms such as “etc.,” “i.e.,” “e.g.,” 
and “re:”) 

• Do not use non-English words. Some readers will not understand the non-English 
word, and even those who do will have to pause and think about it. 

• Short words are easier to process than long words. 

• The active voice is easier to understand than the passive voice. The imperative 
voice is also acceptable in OIT documentation. 
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2.5 Use Consistent Typographic Conventions 
Typographic conventions such as capitalization, punctuation, and emphasis tell 
readers what to expect. Consistent typographic conventions help to define the 
structure of a document. Inconsistent typographic conventions confuse and distract 
the reader. 

2.6 Translatability 
OIT documentation is not formally translated into other languages. However, our user 
group is potentially an English as a Second Language (ESL) group. When users read 
in a nonnative language, they encounter many of the same difficulties a translator 
would encounter when formally translating a document. Therefore, OIT technical 
documentation must be translation friendly. 

A good discussion of writing for translation is found in the Microsoft Manual of Style 
for Technical Publications

2.6.1 Grammar and Translatability 

 (MSTP). Important elements for ease of translation 
include bias-free language and minimal use of humor and anthropomorphism. 

The topics addressed in Section 20.0 cover many of the most common causes of 
translation errors. By following basic grammar guidelines, most situations that cause 
difficulty for translators and nonnative readers can be avoided. These guidelines also 
address the needs of users with limited reading skills, and must be followed 
regardless of the user’s native language. 

2.6.2 Gerunds 
Not all languages use gerunds as nouns, so be aware that a single word in English 
could be difficult to translate or be mistakenly translated as a phrase. 

2.7 Cultural Differences 
Conventions that are taken for granted in a writer’s native language and culture might 
not make sense in other cultures. Keep the following guidelines in mind when 
writing: 

• Do not use political or religious references or examples. 

• Do not use humor. Humor is typically culturally dependent, and understanding of 
a joke can vary across race, gender, sexual orientation, religion, social class, etc. 
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3.0. General Rules 

3.1 Issues Affecting Compliance with Section 508 Guidelines 

3.1.1 Section 508 
Section 508 of the Rehabilitation Act requires that information provided by Federal 
agencies be accessible to people with disabilities. The following description appears 
on the 508 Law page of the Section 508 Web site (http://www.section508.gov/ 
index.cfm?FuseAction=Content&ID=3) 

In 1998, Congress amended the Rehabilitation Act to require 
Federal agencies to make their electronic and information 
technology accessible to people with disabilities. Inaccessible 
technology interferes with an individual's ability to obtain and use 
information quickly and easily. Section 508 was enacted to 
eliminate barriers in information technology, to make available 
new opportunities for people with disabilities, and to encourage 
development of technologies that will help achieve these goals. 
The law applies to all Federal agencies when they develop, 
procure, maintain, or use electronic and information technology. 
Under Section 508 (29 U.S.C. § 794d), agencies must give 
disabled employees and members of the public access to 
information that is comparable to the access available to others. 

3.1.2 Styles and Templates 
Section 508 guidelines require documents created in Microsoft Word to be formatted 
by applying styles, rather than using formatting commands (such as Ctrl-B) or the 
standard toolbar buttons. The use of named styles is required for compliance with 
Section 508 because it permits more accurate tagging by Adobe Acrobat, allowing 
screen readers to correctly read the text aloud. 

The OIT Documentation Team has created a template for each type of RPMS-related 
document (user manual, technical manual, installation manual, etc.). For more 
information about using templates and styles, refer to Section 4.1. 

http://www.section508.gov/index.cfm?FuseAction=Content&ID=3�
http://www.section508.gov/index.cfm?FuseAction=Content&ID=3�
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3.1.3 Carriage Returns (Hard Returns) 

3.1.3.1 In Microsoft Word Documents 
Avoid using carriage returns to add white space in text. Superfluous carriage returns 
barrage screen readers with empty commands that a nonsighted user must wade 
through before finding usable text. Use paragraph spacing (the Before and After 
settings on the Indents and Spacing tab of the Paragraph dialog box) instead. Use 
12 points to replace a single hard return, and 18 points to replace two hard returns. 

Note: An adjustment to paragraph spacing is the only formatting 
change that should be made to text without applying a style 
using the Styles and Formatting
4.1

 pane. Refer to Section 
 for more information. 

3.1.3.2 In Microsoft PowerPoint Documents 
Extra carriage returns used to add white space in PowerPoint documents interfere 
with Section 508 compliance of those documents. Remove all extra carriage returns 
from text blocks in PowerPoint slides. Soft returns (Shift-Enter) are an acceptable 
alternative. 

3.1.4 Color and Backgrounds 
Limit the use of color in technical documents as much as possible. The Section 508 
guidance, Subpart B, Section 1194.22(c), states that “Web pages shall be designed so 
that all information conveyed with color is also available without color, for example 
from context or markup.” For documentation, this standard addresses the needs of 
colorblind and low-vision individuals.  

To make documents Section 508 compliant, remove all watermarks and background 
elements, such as patterns. Choose high-contrast elements, such as dark type and 
graphics against a light, plain background. Avoid similar-color combinations in 
graphics (for example, a bar chart with yellow and light blue bars) and the use of 
contrasting red and green elements. Minimize the use of color and shading in table 
cells. If absolutely necessary for clarity, use only a light, neutral gray or tan to shade 
table heading rows. 

3.1.5 Wingdings 
“Wingdings” are a collection of fonts that render letters as symbols. In technical 
documents, wingdings are occasionally used in place of common list elements, such 
as bullets. However, most screen readers cannot identify wingdings, and wingdings 
cannot be made Section 508 compliant. To make your document compatible with 
Section 508 guidelines, replace all wingdings with standard fonts and common list 
items, such as bullets or dashes (see Appendix A). 
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 Apples 
Problem: 

 Oranges 

 Pears 

 Apples 
Problem: 

 Oranges 

 Pears 

• Apples 

Solutions: 

• Oranges 

• Pears 

3.1.6 Alt Text 
For Section 508 compliance, each image and graphic element in a document must 
have alternate text (“alt text”) associated with it. For more information, refer to 
Section 22.5. 
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4.0. Document Conventions 

4.1 OIT Document Templates 
The OIT Documentation Team has created a template for each type of RPMS 
application-related document (user manual, technical manual, installation manual, 
etc.) that includes the following:  

• The page layout and styles to be used for formatting the document text (headings, 
body text, lists, tables, etc.) 

• A correctly formatted title page (cover page) 

• Formatted headers and footers 

• A table of contents (TOC) 

• Custom document properties 

• Information on the specific sections and content typically found in the specific 
type of document  

The OIT document templates can be downloaded from P:\Document 
Team\RPMSDocTemplates. Contact the OIT Documentation Team or your 
information technology (IT) help desk if you are unable to access this folder. 

Note: 

4.1.1 Using an OIT Document Template 

The use of document templates can be confusing. 
Guidelines for their use are included here, but please 
contact the OIT Documentation Team with any questions 
or problems. 

Templates are often applied to existing documents using the Templates and Add-Ins

To use an OIT document template, follow these steps: 

 
dialog box. However, the OIT document templates are designed to be opened 
separately and used as the basis for new documents, which retains the formatted title 
page, headers, footers, TOC, and custom document properties.  

1. Open the template for the type of document you are creating (user manual, 
installation manual, etc.). 

2. Use the Save As command on the Office Button

3. On the title page, replace “Application Name,” “Namespace,” “#.#,” and “Month 
Year” with the appropriate text. 

 to save the template with the 
name of the document you are creating. 
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4. Type new content directly into each section in the new template-based document, 
or copy and paste text from an existing document. 

4.1.2 Using Styles in OIT Document Templates 
Each OIT template for an RPMS application-related document includes paragraph 
styles for several indented levels of headings, body text, and numbered and bulleted 
lists, as well as character styles for bold, italic, and bold and

The format for each style contained in a template includes settings for font style and 
size, indentation (including hanging indentation if appropriate), paragraph spacing, 
bullet or number style if appropriate, and all other settings required to format a 
document correctly. These settings should not be changed in individual documents 
without the approval of the OIT Documentation Team. Appendix A gives a brief 
description of styles used in most RPMS manuals. 

 italic text. Styles for 
notes and warnings, computer output, tables, table headings and table text, and 
captions for tables and figures are included as well. These styles are designed to 
provide a consistent look and feel for all OIT application-related documentation.  

Note: For compliance with Section 508 guidelines, a document 
must contain only formatting applied using these styles. No 
text should be left in the “Normal” style.  
 
When the OIT Documentation Team produces the final 
508-compliant version of each application-related 
document, any styles and formatting not included in the 
template will be removed

To apply a style contained in a document’s template, open the 

 and the correct styles from the 
template will be applied. 

Styles pane (in the 
Home tab, click Styles [Alt-Ctrl-Shift-S]). Select the text to format, and then click the 
correct style name in the Styles 

For questions or problems using templates and styles, contact the OIT Documentation 
Team. 

pane. 

4.1.3 Fields in OIT Document Templates 
Fields in MS Word documents are used to display specific text, often depending on 
other text in the document or in the document’s properties.  

OIT templates for RPMS-related documents include many different types of fields, 
including the TOC (Section 7.0) and fields in the headers and footers that display 
page numbers, dates, and section titles (refer to Section 4.4 for information on 
headers and footers).  
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In addition, fields for figure and table captions and in-text references to sections and 
captions can be added as the document is written (refer to Section 15.6 for 
information on section headings, Section 22.3 for information on captions, and 
Section 22.4 for information on in-text references). 

When document content that affects fields is revised, fields that depend on that 
content must be updated. Individual fields can be updated when particular content 
changes, but all fields in the document should be updated as the last step before 
finalizing a document. 

• To update a single field, click anywhere in the field and press the F9 key. 

• To update all fields in a document, press Ctrl-A to select the entire document, and 
then press F9. 

Note: 

4.2 Page Dimensions 

If the document is being edited using Track Changes 
(revision marks), it may be less confusing to reviewers if 
the Track Changes feature is turned off before updating the 
TOC field (the field that displays the TOC). 

OIT documents use an 8.5-inch by 11-inch page, in portrait orientation whenever 
possible. All OIT templates for RPMS-related documents include the correct page 
setup settings. 

4.3 Margins 
OIT documents use 1-inch margins on all sides. Certain pages, like externally created 
flowcharts and graphics, can exceed these margins when necessary. All OIT 
templates for RPMS-related documents are set up with the correct margins. 

4.4 Headers and Footers 
Headers and footers, with a line separating the header and the footer from the 
document text, are required for all manuals  

Formatted headers and footers containing the required content are included in all OIT 
templates for RPMS-related documents. Do not

Headers include the package name, the package namespace, and the version number. 
Footers include the manual type (“User Manual,” “Installation Manual,” etc.), the 
page number, the chapter or section name (from the Level 1 heading), and the release 
month and year. 

 edit the header or footer directly; no 
additional editing or formatting should be required. If the header or footer content is 
not displayed correctly, contact the OIT Documentation Team for assistance. 
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4.5 Page Numbering 
Formatted footers containing correctly formatted page numbers are included in all 
OIT templates for application-related documents. Do not

The cover or title page of an RPMS document is not numbered, but is assumed to be 
Page “i.” Front-matter page numbering begins on the first page after the title page 
with lowercase roman numerals (ii, iii, iv, v, etc.), beginning with “ii.”  

 edit the footer directly; no 
additional editing or formatting should be required. If page numbers are not being 
displayed correctly, contact the OIT Documentation Team for assistance. 

The body of the document, beginning with the first page of the Introduction section, 
is numbered using Arabic numerals. 
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5.0. Order of Sections in Documents 
An RPMS-related document produced by OIT contains some or all of the following 
parts, in the following order: 

1. Title page (Section 6.0) 

2. Table of contents (Section 7.0) 

3. Preface (optional) (Section 8.0) 

4. Introduction (Section 9.0) 

5. Content 

6. Appendixes (one or more, optional) (Section 10.0) 

RPMS user manuals must include the RPMS Rules of Behavior (ROB) as one of 
the appendixes (Section 10.5). 

7. Glossary (Section 11.0) 

8. Acronym list (Section 12.0) 

9. Contact information 

OIT templates for application-related documents include headings for the appropriate 
sections in each type of document, and may include dummy text describing the type 
of content expected in a given section. 
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6.0. Title Page 
Each OIT RPMS template contains a correctly formatted title page including (1) the 
Indian Health Service (IHS) and Health and Human Services (HHS) logos and the 
words “Resource and Patient Management System”; (2) dummy text for the package 
name, namespace, version number, and release date; (3) the type of manual (e.g., 
“User Manual”); and (4) OIT’s publication information. 

As described in Section 4.1.1, the correct use of an RPMS template is to save the 
appropriate template as a new document and then add text to that document. This 
preserves the title page in the template, making it unnecessary to create a title page 
from scratch. Be sure to replace the dummy text on the title page with the content for 
the specific RPMS package. 

6.1 Release Dates 
An application’s release date appears on the title page of each document related to the 
application. Each RPMS template includes the dummy text “Month Year” on the 
formatted title page.  

When creating a document using an RPMS template, replace the dummy text on the 
title page with the name of the month and the four-digit year of the release date. Do 
not add a comma after the name of the month. 

Note: The footer in each RPMS template includes a field that 
displays the month and year as displayed on the title page. 
Do not

6.2 Version and Patch Number 

 edit the footer directly; no additional editing or 
formatting should be required. If the release date is not 
being displayed correctly in the footer, contact the OIT 
Documentation Team for assistance. 

An application’s version number (and patch number, if applicable) appears on the 
title page of each document related to the application. Each RPMS template includes 
the word “Version” and the dummy text “#.#” on the formatted title page; the 
RPMS_Addendum template also includes the word “Patch” and the dummy text “#.” 
When creating a document using an RPMS template, replace the dummy text on the 
title page with the appropriate version/patch number. 
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Note: The custom properties included in each RPMS template 
include a “HeaderVersion” property (as well as a 
“HeaderVersion-Patch” property in the RPMS_Addendum 
template); the values of these properties are displayed in 
the header of the document.  
 
Do not

6.2.1 Spelling and Capitalization of “Version” and “Patch” 

 edit the header directly; no additional editing or 
formatting should be required after the 
HeaderVersion/HeaderVersion-Patch property has been set. 
If the version/patch number is not displayed correctly in the 
header, contact the OIT Documentation Team for 
assistance. 

6.2.1.1 Version 
The word “Version” is spelled out and initial capped on the title page and in the 
document header (e.g., Version 5.0). These instances of the word are included in the 
RPMS templates and should not be edited. 

In running text, the word “version” is abbreviated to a lower case “v” without a space 
or period when referring to a specific RPMS package. In all other cases, “version” is 
spelled out in lower case. 

Example: 

Only when referencing the title of a third-party software package or a document in 
running text should the word “Version” be spelled out and initial capped if it appears 
that way in the referenced material. 

In previous versions of the package, the Visit Type could become 
corrupted. In ERS v3.0, this problem has been corrected. 

6.2.1.2 Patch 
In a patch addendum, the word “patch” follows the same rules as the word “version.”  

• It is spelled out with an initial cap on the addendum cover and in the document 
header (e.g., Version 5.0 Patch 1.0).  

• It is abbreviated to a lower case “p” without a space or period when referencing 
the package name in running text. 

• It is spelled out in lower case in all other instances in running text. 
Example: In the previous patch, the Visit Type could become corrupted. In ERS 
v3.0p1, this problem has been corrected. 
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7.0. Table of Contents 
The TOC begins on the first page after the title page. As part of the front matter, the 
page numbers in the Table of Contents section appear as lowercase roman numerals 
beginning with “ii.” 

A TOC is created by inserting a TOC field in an MS Word document. This field 
compiles text styled as headings (“Heading 1,” “Heading 2,” etc.) into a formatted 
TOC.  

Each RPMS template contains a Table of Contents section on the page following the 
title page, with the following elements:  

• A correctly formatted TOC field that generates a table of contents from text styled 
as “Heading 1,” “Heading 2,” and “Heading 3” 

• A header that matches the headers in the rest of the document 

• A footer that matches the footers in the rest of the document and contains a 
correctly formatted page number 

7.1 Updating the Table of Contents 
When new content or sections have been added to a document, the TOC field is 
updated by clicking anywhere in the field (the TOC) and pressing F9.  

• If new sections have been added, select the Update entire table option. Click OK

• If no sections have been added, but content has been added that affects the 
number of pages in any section, select the 

 
to incorporate the new headings into the TOC. 

Update page numbers only option. 
Click OK to revise the page numbers in the TOC. 

Notes: If the document is being edited using Track Changes 
(revision marks), it may be less confusing to reviewers if 
the Track Changes feature is turned off before updating the 
TOC field. 

Do not

In addition, do not edit the header or footer directly; no additional editing or 
formatting should be required. If any element is not displayed correctly in the headers 
or footers in the Table of Contents section, contact the OIT Documentation Team for 
assistance. 

 edit text in the TOC directly; no additional editing or formatting should be 
required after the field has been updated by pressing F9. If the TOC is not displayed 
correctly, contact the OIT Documentation Team for assistance. 
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8.0. Preface (Optional) 
The preface is a brief statement identifying the purpose, scope, and targeted audience 
of a document.  

The preface has historically been a required section located between the title page and 
the TOC. With the 2009 release of the RPMS Programming Standards and 
Conventions, which was updated to conform with The Chicago Manual of Style

When a preface is included, it is now located after the TOC. As part of the front 
matter, the page numbers in the Preface section appear as lowercase roman numerals 
continuing from the final page number in the Table of Contents section. 

, the 
preface is now optional.  

Each RPMS template contains a Preface section on the page following the Table of 
Contents section, with the following elements:  

• A correctly formatted heading 

• A correctly formatted boilerplate paragraph to be replaced with the applicable 
preface text 

• A header that matches the headers in the rest of the document 

• A footer that matches the footers in the rest of the document and contains a 
correctly formatted page number 

Notes: 

In some documents, the preface may be replaced with an Acknowledgments section. 
To ensure that the formatted footer displays the correct section name 
(“Acknowledgments”), replace the word “Preface” in the section heading with the 
word “Acknowledgements,” but 

Do not edit the header or footer directly; no additional 
editing or formatting should be required. If any element is 
not displayed correctly in the headers or footers in the 
Preface section, contact the OIT Documentation Team for 
assistance. 

do not

If a document does not contain a preface or acknowledgments, the entire Preface 
section in the template is deleted. 

 apply a different style to the heading. 
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9.0. Introduction 
The introduction identifies the topic of a document and describes its primary purpose 
or function. It sets the stage for the entire document, and provides a broad frame of 
reference for the reader. The introduction should identify the major topics and issues 
addressed by the RPMS package. It should convey to the reader the major functions 
and purposes of the package and how the software accomplishes those objectives. It 
should not include any technical information.  

The Introduction section is located after the Table of Contents section and after the 
Preface section, if one is present. As the first section in the body of the document, 
page numbers in the Introduction section appear as Arabic numerals beginning with 
“1.” 

Each RPMS template contains an Introduction section on the page following the 
Preface section, with the following elements:  

• A correctly formatted heading 

• A header that matches the headers in the rest of the document 

• A footer that matches the footers in the rest of the document and contains a 
correctly formatted page number 

Note: Do not edit the header or footer directly; no additional 
editing or formatting should be required. If any element is 
not displayed correctly in the headers or footers in the 
Introduction section, contact the OIT Documentation Team 
for assistance. 
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10.0. Appendixes 

10.1 Referring to Multiple Appendixes 
Although many dictionaries consider both “appendices” and “appendixes” correct, 
OIT uses the term “appendixes.” 

10.2 Content of Appendixes 
Appendixes are considered supplemental, and should be used for materials such as 
listings of descriptions or definitions of data elements, sample reports generated by 
the package, summaries of commands, and lists of supportive reference materials. 

Each appendix should be treated as if it were a separate document. This means that 
acronyms must be redefined on first use in each appendix, and each appendix 
includes its own list of references, if appropriate. 

10.3 Appendix Titles 
Appendixes are to be treated independently and lettered accordingly. To assist users 
in navigating appendix information, all appendixes will be labeled in the following 
format: 

Example

A colon and space follow the appendix letter. Do not use a hyphen or em dash 
between the appendix letter and the title, 

: Appendix A: List of Names 

Do not include a section number in the appendix name. Each RPMS template 
includes a style for appendix headings. 

Problem: 11.0 Appendix A—List of Names 

Solution

Section and subsection headings within an appendix appear as single-level headings 
with no numbers or letters. Use the “Subhead” style included in RPMS templates to 
format section headings in appendixes. 

: Appendix A: List of Names 

Example:

10.4 Appendix Location  

 Subsection Title 

Appendixes are placed after the main content and before the Glossary section. 
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10.5 RPMS Rules of Behavior 
The RPMS ROB must be included as an appendix in each RPMS user manual. A 
template file containing the ROB is available from the OIT Documentation Team. 
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11.0. Glossary 
The Glossary section is reserved for definitions of words and complex terms in the 
text. It is not a substitute for the acronym list (Section 12.0). The words and terms 
included in the glossary should reflect those unique to the subject matter. 

Create the glossary as follows: 

• Apply the “GlossTerm” style found in RPMS templates to the word or phrase to 
be defined. Add a carriage return after the word or phrase. 

• Type the definition of the word or phrase and apply the “bdytxt3” style. The 
“bdytxt3” style also automatically follows an entry made in the “GlossTerm” 
style once you press the Enter key. 

Example

Baseline Year 

: 

CRS calculates and reports on results for and comparisons between three time 
periods for each measure: the current year (defined by the user); the previous 
year; and the baseline year. Baseline is defined by the user at the time s/he 
runs the report. The Area GPRA coordinator should ensure that for GPRA and 
Area Performance reports, each facility uses the same baseline year; otherwise 
the area’s aggregate report will not calculate properly. 

ICD Codes 
One of several code sets used by the healthcare industry to standardize data. 
The International Classification of Disease is an international diagnostic 
coding scheme. In addition to diseases, ICD also includes several families of 
terms for medical-specialty diagnoses, health status, disablements, procedure 
and reasons for contact with healthcare providers. IHS currently uses ICD-9 
for coding.  
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12.0. Acronym List 
Every acronym and initialism in a technical document should appear in the Acronym 
List section, which appears after the Glossary section. An acronym list allows readers 
who have not read the document from beginning to end to find the definition of an 
acronym quickly. The acronym list provides only

11.0
 the spelled-out form of the 

acronym: it is not a substitute for a glossary (Section ). 

Abbreviations are not included in the acronym list. 

Acronyms are listed alphabetically in the acronym list, and are singular, not plural 
(unless the acronym is always plural). Acronyms appear in bold face, with the spelled 
out terms set in “bdytxt1” style.  

Create an acronym list by inserting a table with two columns into the document, 
hiding the gridlines. List the acronyms in the first column, and the corresponding 
spelled-out terms in the second column.  

Example: 

IHS Indian Health Service 

OIT Office of Information Technology 

RPMS Resource and Patient Management System 
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13.0. Section and Page Breaks 
In general, do not manipulate pagination or page breaks by inserting section breaks or 
hard page breaks. Explicit page or section breaks in Word documents often create 
problems when text is edited or rearranged. Use paragraph formatting such as the 
Keep with next and Keep lines together
13.3

 options instead, as described in Section 
. 

13.1 Section Breaks 
The RPMS templates include section breaks (Next page

• Between the title page and the TOC  

 type) in the following 
locations: 

• Between the TOC and the introduction 

• Between the final body section of the document and the Glossary section 

• Between the Glossary section and the Acronym List 

• Between the Acronym List and the first Appendix section 

• Between the final Appendix section and the Contact Information section 
Do not insert additional section breaks unless absolutely necessary.  

Note:

13.1.1 Forcing Odd and Even Start Pages 

 In very rare circumstances, it may be necessary to insert 
one or more additional section breaks (such as when 
inserting a landscape-formatted table or figure in a portrait-
oriented document, or in documents with very large 
sections). 
 
Be aware that adding section breaks to a document based 
on an OIT document template may cause problems with 
headers and footers. If you encounter problems with this 
process, contact the OIT Documentation Team for 
assistance. 

Because all OIT documentation is designed to be viewed onscreen (according to the 
Paperwork Reduction Act of 1996), extra pages included to start sections specifically 
on even or odd pages are no longer necessary.  

In addition, users who chose to print a paper copy of the manual may not have access 
to printers that allow double-sided printing. Extra pages added to force odd or even 
start pages would force users to print unnecessary blank pages. 
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Do not insert section breaks to force odd or even start pages. 

13.2 Page Breaks before Section Headings 
The “Heading 1” style in RPMS templates is formatted to insert a page break before 
the heading.  

All other heading styles do not

Do not add a section break before a section heading unless directed to do so by the 
OIT Documentation Team. 

 take a page break before the heading. 

13.3 Hard Page Breaks 
Do not use hard page breaks to keep text together across a natural page break. Instead 
use the Keep lines together (which keeps selected lines of text together) and/or Keep 
with next (which keeps selected paragraphs together) settings on the Line and Page 
Breaks tab of the Paragraph

13.4 Page Breaks in Tables 

 dialog box. These settings allow the text to be broken 
in the appropriate place, rather than forcing a page break that may not be correct after 
text is edited and rearranged. Widow/Orphan Control prevents a single header or line 
of a paragraph from displaying at the bottom of a page. 

13.4.1 Repeated Header Rows  
If a table spans one or more page breaks, the table must be formatted to repeat the 
header row or rows on each page.  

To repeat one or more header row, select the row or rows, and then select the Header 
Row option in the Table Style Options area of the Design tab, or the Repeat as 
header row at the top of each page option on the Row tab of the Table Properties

Because it’s impossible to know whether a table will break across pages after a 
document has been edited or rearranged, the OIT Documentation Team practice is to 
apply this setting to all tables. 

 
dialog box (from the context menu). 

13.4.2 Page Breaks within Table Rows 
Because a table row or cell that includes a page break can cause problems with screen 
readers, thus making a document inaccessible, tables must be formatted so that pages 
cannot break within table rows.  
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To disallow page breaks within table rows, select the table, and then clear the Allow 
row to break across pages option on the Row tab of the Table Properties

Because it’s impossible to know whether a table will break after a document has been 
edited or rearranged, OIT Documentation Team practice is to apply this setting to all 
tables. 

 dialog 
box.  
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14.0. Text Alignment, Spacing, and Font 

14.1 Text Alignment 
In most cases, document text is left aligned on a 0.75-inch left margin with no 
paragraph indents, no hyphenation, and no right justification. The “bdytxt1” style in 
RPMS templates is formatted correctly for body text throughout each document. 

If a separate paragraph appears within a bulleted or numbered list item, it must be 
indented to the same level as the text in the bullet or numbered list style. The 
“bdytxt2” style in OIT templates is formatted for use with the “Bullet1,” “ListNum,” 
and “Number” styles, and the “bdytxt3” style in OIT templates is formatted for use 
with the “Bullet2” and “NumberIndent” styles. (The “bdytxt3” style is also used with 
the “GlossTerm” style.) 

• The text in the “Bullet1” style is indented at 1 inch from the left margin, so a 
paragraph appearing within a Bullet1 list item must also be indented at 1 inch. 

Example: 

The “bdytxt2” style is indented at 1 inch, so it can be used as a separate paragraph 
within a Bullet1 list item. 

14.2 Text Spacing 
The text styles in RPMS templates have been formatted to support consistent spacing 
standards. As described in Section 4.1.1, use the appropriate template for each RPMS 
document, and apply these styles to text in the document using the Styles 

14.2.1 Paragraph Spacing 

pane. For 
more information or assistance with these procedures, contact the OIT 
Documentation Team. 

The “bdytxt1,” “bdytxt2,” and “bdytxt3” styles for general and indented paragraph 
text incorporate the correct amount of space after each paragraph. Use one of these 
styles for all paragraph text in a document, depending on the level of indentation 
required.  

The “Bdytxt1 Leadin,” “Bdytxt2 Leadin,” and “bdytxt3 Leadin” styles have a smaller 
amount of space after the paragraph. Use one of these styles for a paragraph that 
introduces a bulleted or numbered list.  
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14.2.2 List Item Spacing 
The “Bullet1,” “Bullet2,” “Bullet3,” “Dash1,” “Dash2,” “Dash3,” “ListNum,” 
“Number,” and “NumberIndent” styles incorporate the correct amount of space after 
each list item. Use these styles for all list items. 

14.3 Standard Font and Type  

14.3.1 Standard Paragraph Text 
The text styles in the RPMS templates have been formatted to consistent font style 
and size standards. As described in Section 4.1.1, use the appropriate OIT template 
for each type of RPMS document, and apply these styles to text in the document 
using the Styles 

14.3.2 User Input 

pane. For more information or assistance with these procedures, 
contact the OIT Documentation Team. 

The characters that a user is instructed to type at a roll-and-scroll prompt or in a 
graphical user interface (GUI) control (for example, a text box) are indicated by bold 
type. Format bold type by applying the “Bold” character style in the document’s 
template.  

Example: Type PTRG

Refer to Section 

 at the main menu prompt. 

20.0 for more information on writing user instructions. 

Note: Do not use Ctrl-B or the “B

14.3.3 Text Captured from Roll-and-Scroll Computer Screens 

” toolbar button to indicate user 
input. Text formatted using either of these methods is not 
compliant with Section 508 standards. 

Text capture blocks from roll-and-scroll computer screens are formatted using 
Courier font, a 1-point border, and a lightly shaded background. The “computer 
output” and “computer screen” styles available in OIT templates incorporate this 
formatting. Refer to Section 23.0 for more information on formatting roll-and-scroll 
text captures. 
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Select one of the following: 

Example: 

 
   C         By CLINIC NAME for a specified appointment date range 
   P         Selected Patients w/Appointments 
   D         One Facility's or Divisions Appointments 
   A         Any selected set of patients regardless of appt status 
 
Create List/Sort by: C//  

14.4 Italic Type 

C <Enter> 

Use italics for small areas of emphasis. Overused italics quickly lose their force. 

14.5 Underlined Type 
Underlined text is reserved for identifying hyperlinks. 

Do not use underlining for headings or to emphasize particular sections of text. Use 
the heading styles available in OIT templates, and use italics for emphasis. The 
“Notes” and “Warning” styles can also be used to highlight appropriate sections of 
text. 

14.6 Bold Type 
Do not use bold type for emphasis.  

Use bold type for user input and the names of user interface controls in 
documentation for GUI applications. Refer to Section 20.0 for more information on 
writing user instructions. 

Bold formatting is also included in the settings for heading styles in the RPMS 
templates. As with all other styles in the templates, these settings may not be edited.  

Note: Do not use Ctrl-B or the “B” toolbar button to format bold 
type. Text formatted using either of these methods is not 
compliant with Section 508 standards. 

Example: At the “Home” prompt, type 0;P-OTHER80 and press Enter. 

Example: Select a location from the Location list. 
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14.7 Heading Font and Alignment 
The “Heading 1,” “Heading 2,” “Heading 3,” and “Heading 4” styles in the RPMS 
templates have been formatted for consistent font, font size, and alignment for each 
heading level across all RPMS documentation.  

All headings and subheadings are placed at the left margin without incremental 
indentation. Headings are not underlined. 

As described in Section 4.1.1, use the appropriate OIT template for each RPMS 
document, and apply these styles to text in the document using the Styles pane. For 
more information or assistance with these procedures, contact the OIT 
Documentation Team. 
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15.0. Numbers and Numbering 

15.1 Numbers in Text 
The whole numbers zero through nine are spelled out in running text, unless followed 
by a fraction (Section 15.2). The numbers 10 and above are left as numerals. This rule 
does not apply to item numbers in numbered lists, page numbers, numbers used as 
measurements, or in screen captures or roll-and-scroll text captures. 

When a number less than 10 and a number greater than 10 appear in the same 
sentence, all numbers are expressed as numerals, unless the first word of the sentence 
is a number. 

The company owned 150 trucks, employed 271 people, and rented 7 warehouses. 
Example: 

Spell out numbers in the following situations: 

• Common units of time greater than one second, from zero to nine  

• Approximations  

• Any number that begins a sentence 

• Extreme values (such as million), but precede the value with a numeral 

Use numerals in the following situations: 

• Negative numbers 

• Percentages, decimals, and measurements 

• Units of time smaller than one second 

• References to bits and bytes 

15.2 Fractions 
Use numerals for fractions in tables and in units of measurement, but in prose, spell 
out fractions less than one (e.g., “one-half,” “three-fourths”) using a hyphen.  

Do not use a space between a numeral and a related fraction. If a fraction is used in a 
compound modifier, use numerals and insert a hyphen between the fraction and the 
unit of measurement. 

Problem: You will see ½ of the patient names on the first screen. 

Problem: You can set your system to automatically create 1 ½ inch margins. 



OIT Standards and Conventions v2.0 

Documentation Style Guide Numbers and Numbering 
November 2010 

30 

Solution: You will see one-half of the patient names on the first screen. 

Solution: You can set your system to automatically create 1½-inch margins. 

Example:

15.3 Page Numbering 

 He added 5½ to the total. 

The title page of an RPMS document is not numbered. Front-matter page numbering 
begins on the first page after the title page (the first page of the TOC) with lowercase 
roman numerals (i, ii, iii, iv, v, etc.). The body of the document is numbered using 
Arabic numerals beginning on the first page after the end of the Table of Contents 
section. 

Formatted footers containing correctly formatted page numbers are included in all 
RPMS templates.  

Note: 

15.4 Figure Numbering 

Do not edit the footer directly; no additional editing or 
formatting should be required. If page numbers are not 
being displayed correctly, contact the OIT Documentation 
Team for assistance. 

Use Word’s Insert Caption dialog box from the context menu to create 
autonumbered figure captions. For more information on figure captions and the 
Insert Caption 22.3 dialog box, refer to Section . 

Figures are numbered in the 1-1 format, where the first number corresponds to the top 
level (Heading 1) section number and the second number corresponds to the order of 
the figure within that section. The figure number appears in the figure caption.  

15.5 Item/List Numbering 
Use a numbered list only if the items must be completed in a particular order or if the 
numbering is critical to understanding the list or items. If there is no explicit reason to 
use a numbered list, use a bulleted list instead. 

Refer to Section 21.0 for information on structuring numbered and bulleted lists. 

15.6 Heading Numbering 
Heading levels 1 through 4 are numbered in legal/outline style (1.0, 1.1, 1.1.1, 
1.1.1.1). The headings in this document are numbered and formatted correctly. 



OIT Standards and Conventions v2.0 

Documentation Style Guide Numbers and Numbering 
November 2010 

31 

The “Heading 1,” “Heading 2,” “Heading 3,” and “Heading 4” styles in the RPMS 
templates have been configured to support consistent numbering and formatting for 
the four heading levels. As described in Section 4.1.1, use the appropriate template 
for each document (user manual, technical manual, etc.), and apply these styles to text 
in the document using the Styles pane. For more information or assistance with these 
procedures, contact the OIT Documentation Team. 
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16.0. Abbreviations and Acronyms  
An abbreviation is a shortened form of a word or phrase that takes the place of the 
full word or phrase (e.g., “Dr.,” “Mr.,” “Ms.,” “am,” “pm”). 

“Acronym” refers to terms composed of the initial letters of their individual 
components that are read as a single word (e.g., “AIDS,” “NATO”). 

“Initialism” refers to terms composed of the initial letters of their individual 
components that are read as a series of letters (e.g., “BBC,” “ATM”). 

“Acronym” is used to refer to both acronyms and initialisms in this document. 

16.1 Using Abbreviations 
Abbreviations are usually familiar and do not need any explanation. Less familiar 
abbreviations (e.g., medical terms) should be spelled out at first use. 

Abbreviations should only be used in contexts where they are clear to readers. 
Some are almost never used in spelled-out form, and others, though in common 
use, are normally spelled out at first occurrence as a courtesy to readers. {The 
Chicago Manual of Style (15th Edition)} 

Do not use “w/,” “w/out,” “w/o,” “&,” “+” (instead of “and”), or “thru.” These 
abbreviations make it difficult for a screen reader to accurately read the text out loud. 

16.1.1 Units of Measure 
Do not abbreviate common units of measurement (“in.,” “ft”). Use the word “inches” 
instead of the inch symbol (″). 

16.2 Using Acronyms and Initialisms 
If an acronym appears more than once in a document, the full term is spelled out (and 
defined, if necessary) on first use, followed by the acronym or initialism in 
parentheses. Acronyms should not be defined in headings at first use. In this situation, 
they should be spelled out in the heading and defined in the text below. After the first 
use of the term, use only the acronym or initialism without the parenthetical 
explanation.  

If the term is only used once, it is spelled out and the acronym is not used. 

Problem: The OIT headquarters are staffed with competent professionals. 

Solution: The Office of Information Technology (OIT) Support Center headquarters 
are staffed with competent professionals. 
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Problem: Patient Chart is IHS’s first GUI program. 

Solution

16.2.1 Acronym List 

: Patient Chart is IHS’s first Graphical User Interface (GUI) program. 

All acronyms and initialisms in the document should appear in alphabetical order in 
the Acronym List section following the Glossary. Refer to Section 12.0 for more 
information on the structure of the acronym list. 

Abbreviations are not included in the acronym list. 

16.2.2 Acronyms in the Glossary 
Acronyms may also appear in the glossary with a more complete definition if 
necessary, but do not use the Glossary section as a substitute for the acronym list. 

16.2.3 Acronyms with Indefinite Articles 
The article used with an acronym (“a” or “an”) depends on the pronunciation of the 
acronym. 

Examples: A North Carolina State University (NCSU) professor; an NCSU 
professor; a NATO treaty 
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17.0. Capitalization 
“Title case” or “title-style capitalization” refers to text in which the first letters of 
most words are capitalized, such as the titles of books or articles. The rules for title 
case are described in of The Chicago Manual of Style (15th Edition)
“Sentence case” or “sentence-style capitalization” refers to text in which only the first 
word of a sentence, and any proper nouns, are capitalized. The rules for sentence-
style capitalization are described in Section 8.166 of 

, Section 8.167 

The Chicago Manual of Style 
(15th Edition)
“Initial capitals” or “initial caps” refers to text in which only the first word and any 
proper nouns in a phrase are capitalized. 

. 

Section headings are set in title case. Refer to Section 15.6 for more information 
about headings styles and formatting. 

In general, capital letters are used in the following situations: 

• All letters in acronyms 

• The initial letter of the first word in a list item  

• The initial letter of the first word in a callout  

• The initial letter of a key name (“Enter,” “Ctrl,” “Shift,” “Alt,” “Tab”) 

• The initial letter of a sentence. 

Avoid starting a sentence with a command name or application name if it has a 
lowercase initial letter (e.g., “iCare,”  etc.). 

Ask the point of contact to verify capitalization of all variables, field names, options, 
keys, file names, etc. that cannot be verified by examining roll-and-scroll text 
captures. 

Do not use capital letters for emphasis; use italics instead. (Bold is reserved for user 
input, and underlining is reserved for hyperlinks.) 

17.1 Capitalization in Captions  
Use sentence case capitalization. 

17.2 Capitalization in Table Titles 
Use sentence case. 
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17.3 Capitalization of Window Parts 
For window titles, match the capitalization in the software. Do not capitalize the word 
“window.” 

Example: The Open File

Do not capitalize words such as “field,” “tab,” “pane,” “button,” or “list box.” 

 window is displayed. 

Example

Do not capitalize the names of window types. 

: The Personal tab is displayed. 

Example

17.4 Capitalization of Key Names 

: A warning window is displayed. 

Match capitalization on the keyboard. Always follow the name of a key with the word 
“key,” but do not capitalize “key” when it follows the name of a key.  

Problem: Press the Enter Key.  

Solution

17.5 Capitalization of RPMS Package Names and 
Namespaces 

: Press the Enter key.  

Use initial caps for RPMS package names. Spell out the full package name at first 
use, followed by the abbreviation or namespace in parentheses. After a package name 
has been introduced this way, use the abbreviation or namespace throughout the 
document. Namespaces are rarely acronyms for the package name. 

Example: 

Always use the word “package” when referring to an RPMS package, but do not 
capitalize the word “package” unless the entire phrase is initial capped, such as in 
headings.  

The Radiology package (RA) can be downloaded. The RA package is… 

17.6 Capitalization of Field Names 
Match the onscreen capitalization of field names. Do not use all capital letters for a 
field name unless that is how it appears on the screen. 

Ask the point of contact to verify capitalization of all variables, field names, options, 
keys, file names, etc. that cannot be verified by examining roll-and-scroll text 
captures. 
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17.7 Capitalization of File Names  
Ask the point of contact to verify capitalization of all variables, field names, options, 
keys, file names, etc. that cannot be verified by examining roll-and-scroll text 
captures. 

17.8 Capitalization of Option Names  
Match the onscreen capitalization of option names. 

Ask the point of contact to verify capitalization of all variables, field names, options, 
keys, file names, etc. that cannot be verified by examining roll-and-scroll text 
captures. 

All option names must be followed by the word “option” to distinguish option names 
from other elements. Do not capitalize the word “option” when it follows the option 
name. 
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18.0. Punctuation  
Use standard American English punctuation rules. Refer to the The Chicago Manual 
of Style (15th Edition) for punctuation guidelines not addressed in this section.  

18.1 Brackets ([])  
Do not use brackets ([ ] or { }) as a substitute for parentheses. Use square brackets  
([ ]) within parentheses, if necessary. 

18.2 Colon (:) 
Use a colon following a complete sentence to introduce a list or procedure (Section 
21.5).  

Do not use a colon to introduce a figure or table in the text or to introduce heading 
titles. 

Exceptions to this rule include the use of a colon to separate a figure number from the 
accompanying description in a caption (e.g., Figure 2-2: Profit graph) or when a 
heading has two parts (e.g., Appendix A: List of Names). In both of these cases, a 
single space follows the colon. 

18.3 Commas 
Follow standard comma rules. For items in a series, use a serial comma (a comma 
preceding the “and” or “or” before the final item) to add clarity. Commas are not 
needed in a series whose elements are all joined by conjunctions, unless the elements 
are long and pauses are helpful. 

Example: Was that document written by Jane or Joe or Barry? 

Problem: Jane, Joe and Barry are in charge of the Radiology package. 

Solution

18.4 Ellipsis Points (…) 

: Jane, Joe, and Barry are in charge of the Radiology package. 

Use ellipsis points (…) to indicate the omission of a word, phrase, line, paragraph, or 
more from a quoted sentence. The ellipsis points must always appear together on the 
same line. Ellipsis points are normally not used before the first word of a quotation or 
after the last word of a quotation, unless the sentence as quoted is deliberately 
incomplete. Refer to The Chicago Manual of Style (15th Edition), Section 11.51 for 
more information. 
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18.4.1 Ellipsis Points in Roll-and-Scroll Documentation 
Ellipsis points that appear after an option name in RPMS applications indicate that 
the option has a submenu. In roll-and-scroll text capture blocks, be sure the ellipses 
points appear in the text capture. 

Examples
PTRG Patient Registration Menu… 

: 

SIT Set Default Facility… 

AGX Data Export Menu… 

18.4.2 Ellipsis Points in GUI Documentation 
Ellipsis points that appear after menu options or on buttons in GUI applications 
indicate that the option or button opens a dialog box. Do not include the ellipsis 
points when referring to these options or buttons in user instructions. 

Problem: On the Format menu, click Paragraph… to open the Paragraph dialog 
box. 

Solution: On the Format menu, click Paragraph to open the Paragraph

18.5 Em Dash (—) 

 dialog box. 

Follow the guidelines in The Chicago Manual of Style (15th Edition)

In OIT documents, em dashes may be used in place of a comma or parentheses to 
amplify or explain. 

, Sections 6.87 
through 6.94, to determine whether or not to use an em dash. Do not add a space 
before or after an em dash. 

Do not use an em dash in list items with introductory words or phrases; refer to 
Section 21.6.4 for the correct way to construct this kind of list. 

Do not use an em dash in section headings or between the word “Appendix” and the 
name of the appendix. 

18.6 En Dash (–)  
Use an en dash in ranges of dates, times, and numbers. Do not add a space before or 
after an en dash. 

Examples: 1989–1995 
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Do not use an en dash if the word “from” or “between” precedes the first element in 
the range. Use the word “to” or “through” instead of the en dash with “from,” and use 
the word “and” with “between.” 

Problem: The application was in use from 1995–2006. 

Solution: The application was in use from 1995 to 2006. 

Problem: This report was based on data collected between January–December. 

Solution: This report was based on data collected between January and December. 

Note: The en dash is sometimes used as a minus sign, but minus 
signs and en dashes are distinct characters. Use the correct 
character (in Word, select Symbol in the Insert

18.7 Hyphens 

 tab) for the 
minus sign. 

Follow the extensive rules in The Chicago Manual of Style (15th edition), Sections 
7.82 through 7.90, to determine whether or not to use a hyphen in a compound word, 
or consult the Merriam Webster Collegiate Dictionary (most recent edition) or 
Merriam Webster Online Dictionary (http://www.m-w.com/dictionary.htm).  

Note: Many prefixes do not use a hyphen unless the following 
word is a proper noun, or if omitting the hyphen would 
cause confusion in the context of the document. The 
Chicago Manual of Style (15th Edition)

Do not use a hyphen with an adverb ending in “ly,” or with words that are listed as 
unhyphenated in the 

, Section 7.90, lists 
general and specific rules for hyphenating words formed 
using prefixes. 

Merriam Webster Collegiate Dictionary

18.8 Parentheses () 

. Do not use a hyphen to 
allow a word to break across lines. 

Use parentheses for tangential material. If the material is crucial to the sentences, 
parentheses are inappropriate. Use parentheses to introduce abbreviations and 
acronyms that you will use later or to reference other sections or figures. 

Example: The Patient Demographic dialog box is displayed (Figure 2-2). 

Problem: Use the graphical user interface or GUI to perform the task. 

Solution: Use the graphical user interface (GUI) to perform the task. 

http://www.m-w.com/dictionary.htm�
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18.9 Punctuation after Italicized or Bold Text 
To avoid confusion, punctuation that follows an emphasized item, names of user 
interface controls, or user input text is not italicized or bolded. 

Example: Select the file. Click Open

18.10 Punctuation in Numerals  

, and then locate the item in the file. 

Do not use a comma in four-digit numerals. Use a comma in numerals of five or more 
digits. 

18.11 Punctuation Marks Used as Commands  
Many of the RPMS packages use punctuation marks as command and navigational 
responses. When a punctuation mark is used in this context, you must spell out the 
name of the mark and give a parenthetical example immediately following. If the user 
is expected to type the punctuation mark, it appears in bold type within the 
parentheses. 

Examples
Type a question mark (

: 

?

Type an ellipsis (

) at the “Name” prompt to see a list of options. 

…

Type a caret (

) at the “Replace:” prompt to select all of the existing text for 
replacement. 

^

18.12 Quotation Marks (“ ”) 

) at the “Device:” prompt. 

Use quotation marks to indicate material that is taken verbatim from another source. 
This does not include boilerplate information or information from previous 
documentation versions. 

Use quotation marks once

When referring to a word itself rather than the concept represented by the word, use 
either italics or quotation marks to set the word apart from the rest of the text. 

 when using a familiar word in an unfamiliar context. Do 
not continue to use quotation marks after the first use of the word. 

Example:

Use quotation marks around prompts in procedure steps for roll-and-scroll 
applications. 

 Use the serial comma preceding the “and” or “or” before the final item in a 
series. 
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Example: To select the Patient Registration menu, type PTRG

18.13 Punctuation in Quotation Marks 

 at the “Option” 
prompt. 

Periods and commas go inside quotation marks. Other punctuation (colons, question 
marks, etc.) go outside quotation marks, unless they are part of the quoted material. 

18.14 Semicolon (;) 
Use a semicolon before a phrase that introduces an explanatory or summarizing 
statement. Use a semicolon to separate independent clauses joined by conjunctive 
adverbs, such as “therefore.” Use a semicolon to separate items in a series when each 
item contains one or more commas.  

18.15 Slash (/) 
Use the slash sparingly. Do not use it as a substitute for “or.” 

Do not put a space before or after a slash. 

Example

18.16 Space after Periods 

: and/or Mechanics 

Use one space, not two, after a period at the end of a sentence. 
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19.0. Grammar 

19.1 Tense 
In general, use the present tense in OIT documents. Restrict the use of the future tense 
to circumstances that will happen at some future time, such as next year. 

In general, avoid conditional phrases and past tenses. 

Problem: The user will type ARMS at the menu. 

Solution: Type ARMS at the menu. 

Problem: At the Options prompt, type PTRG. The Patient Registration menu will 
be displayed. 

Solution: At the Options prompt, type PTRG. The Patient Registration menu is 
displayed. 

Problem: If you are missing any drives that might have been added to your machine, 
you may right-click on an empty space and… 

Solution

When describing the steps taken by a user in an example, use the past tense. 

: If any drives are missing from your machine, right-click an open space on 
the desktop and… 

Example: The user typed ARMS

19.2 Split Infinitives 

 at the menu. 

Adverbs sometimes separate the word “to” from the principal verb. Avoid split 
infinitives, but do not mutilate a sentence to remove one.  

Although from about 1850 to 1925 many grammarians 
stated otherwise, it is now widely acknowledged that 
adverbs sometimes justifiably separate the to from the 
principal verb. {The Chicago Manual of Style (15th 
Edition)} 

Example:

If the adverb bears the emphasis in a phrase {to boldly go} 
{to strongly favor}, then leave the split infinitive alone. But 
if moving the adverb to the end of the phrase doesn’t 
suggest a different meaning or impair the sound, then it is 
an acceptable way to avoid splitting the verb. Recasting a 

 They expect to more than double their income in the following year. 
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sentence just to eliminate a split infinitive or avoid splitting 
the infinitive can alter the nuance or meaning: for example, 
it’s best to always get up early (always modifies get up) is 
not quite the same as it’s always best to get up early 
(always modifies best). Or an unnatural phrasing can result: 
it’s best to get up early always

19.3 Adverbs and Adjectives  

. {The Chicago Manual of 
Style (15th Edition)} 

Use adverbs and adjectives sparingly. Adverbs are generally not necessary in 
technical content; use adjectives only when necessary for descriptive purposes. 

If an adverb is necessary to qualify the function of a component, it should appear as 
close as possible to the word it modifies to avoid confusion. In all cases, test whether 
the phrase can stand alone without the adverb.  

Words such as “simply,” “obviously,” and “clearly” can appear condescending in 
some contexts, so be aware of the tone of the document when determining whether 
such words are used appropriately. 

Problem: Simply press the Enter key when you are finished. 

Solution

If an adjective is necessary to differentiate between items, use the adjective. In all 
cases, test whether the phrase can stand alone without the adjective.  

: Press the Enter key when you are finished. 

19.4 Contractions 
Do not use contractions (e.g., “can’t,” “doesn’t,” “isn’t,” “don’t”). “Cannot” is not a 
contraction. 

19.5 Gerunds 
Do not use gerunds when they could be mistaken for adjectives. 

Problem: Clicking Programs opens the Programs
(If the programs are literally clicking, something is wrong with your computer!)  

 menu. 

Solution: Click Programs to open the Programs menu. 

Exception: Gerunds are appropriate in section headers; for example, “Using the 
Menu Editor.” 
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19.6 Passive Voice 
In general, use the active voice. The passive voice can almost always be rewritten to 
use the active voice. 

Problem: The Menu Editor is started from the Main Menu. 

Solution: Start the Menu Editor from the Main Menu. 

Problem: When you click Find, the Find dialog box is displayed. 

Solution: Click Find to display the Find dialog box. 

Exceptions:

19.7 Indefinite Pronouns 

 If the sentence does not make sense in the active voice, then use the 
passive, but limit the occurrences. The passive voice is also used to avoid 
personalization of the application or computer and to prevent bringing the developer 
or other individuals into the text as subjects. 

Restrict the use of indefinite pronouns such as “it,” “this,” and “those,” especially at 
the beginning of sentences. If you must use an indefinite pronoun, be sure to clarify 
what the pronoun is referring to. 

Problem: The Menu Editor is a configuration tool for the Main Menu. This is useful 
in setting your system to your system requirements. 

Solution

Figures of speech, such as “It is recommended,” are acceptable uses of indefinite 
pronouns. 

: The Menu Editor is a configuration tool for the Main Menu. This tool is 
useful in setting your system to your system requirements. 

19.8 “There Is”/“There Are” 
The terms “there is” and “there are” are ambiguous and should be avoided. 
Alternative phrasing generally creates stronger syntax and reduces the number of 
superfluous words. 

Problem: There are two main menu lists in the menu tree. 

Solution

19.9 Sentence Length and Concise Statements 

: The main tree contains two main menu lists. 

In general, concise sentences should not exceed 25 words. Express one idea per 
sentence and trim unnecessary words. 
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Try to keep procedure steps to less than 25 words as well. In general, each procedure 
step should express a single action; however, instructing the user to press the Enter 
key at the end of an entry does not require a separate step. 

Problem: If you would like to place a menu item onto the desktop, you can drag and 
drop from the menu to the desktop and it will place an icon there with all the 
appropriate properties set for you. 

Solution

19.10 Personal Pronouns 

: Drag a menu item from the menu to the desktop. The drag action places an 
icon with the appropriate properties on the desktop. 

In technical documentation, do not use the personal pronouns “I” and “we,” and limit 
the use of “you,” “he,” “she,” and “they.” 

Problem: We recommend this method of moving a symbolic link. 

Solution

Problem: In this section, we describe the interface. 

: Use this method to move a symbolic link. 

Solution: This section describes the interface. 

19.10.1  “The User” 
Do not use “the user” except when describing an example of a user’s session with an 
application. Examples of this type are unusual in RPMS documentation. 

Example: After selecting the RPT option to display the Reports Menu, the user 
typed NTL to display the National GPRA Reports Menu

Never refer to “the user” in instructions for performing tasks using an application. 

. 

Problem: The user clicks Select next to the Provider box to display the Provider 
window. 

Solution: Click Select next to the Provider box to display the Provider

19.11 Use of May 

 window. 

Avoid the use of “may.” Replace “may” with “can” or “might.” 

Problem: These settings may be accessed from the Control Panel dialog box. 

Solution: These settings can be accessed from the Control Panel dialog box. 
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Exception

19.12 Articles 

: Use “may” only when you grant permission to do something. 

Do not omit articles. 

Problem: Open Main Menu and select item. 

Solution

19.13 When and If 

: Open the main menu and select an item. 

Use “when” for an inevitable event and “if” for a conditional event.  

For example, “When the prompt is displayed” implies that the prompt is definitely 
displayed, while “If the prompt is displayed” implies that the prompt might or might 
not be displayed. 

19.14 Colloquial Language 
Do not use colloquial language. 

Problem: The Modem Lights Applet is a handy applet that will start your dial up 
connection. 

Solution: The Modem Lights applet starts your dial up connection. 

Problem: At times, the QMan application may act brain damaged. 

Solution:

19.15 Omission of “That” 

 At times, the QMan application may respond erratically. 

Do not omit the word “that” traditionally found in the beginning of a conditional 
phrase or after “ensure.” Removing “that” makes the sentence more difficult for 
nonnative English speakers. 

Problem: Ensure you have typed the right username. 

Solution: Ensure that you have typed the right username. 

Problem: Some engineers fail to recognize sufficiently the human beings who 
operate the equipment constitute an important safety system.  

Solution: Some engineers fail to recognize that the human beings who operate the 
equipment constitute an important safety system. 
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20.0. User Instructions 
The RPMS family of applications includes both text-based roll-and-scroll 
applications and GUI applications. While user instructions for both types of 
application follow the same general principles, there are distinct standards and 
conventions that apply to each type separately 

Sections 20.1 and 20.2 outline general principles applicable to all RPMS 
documentation. Section 20.3 contains guidelines for documenting roll-and-scroll 
applications, and Section 20.4 contains guidelines for documenting GUI applications.  

20.1 Referring to Keys and Keystrokes 

20.1.1 “Type” vs. “Enter” 
When instructing the user to input specific information at a roll-and-scroll prompt or 
in a GUI text box, always use the word “type” instead of “enter.”  

Example:

Use “enter” only when referring to general functions such as data entry. 

 Type the patient’s full name at the “Select Patient Name” prompt. 

Example: Use the Patient Registration Menu

20.1.2 Enter/Return Key 

 option to enter patient data into the 
system. 

When instructing the user to press the Enter key, use the phrase, “Press Enter.” 
Always use the word “press” instead of “hit,” “strike,” etc. 

Capitalize the key name as it appears on the keyboard. Do not use any additional 
punctuation or formatting when referring to the Enter key or any other key. 

Problem: Press RETURN. 

Problem: Hit <Return>. 

Problem: Type the patient’s name and press the Return Key. 

Solution: Type the patient’s name and press Enter. 

Exception: When adding annotations to a roll-and-scroll text capture, the notation 
“<Enter>” can be used to indicate that the Enter key was pressed. In this case, the 
notation for the Enter key (<Enter>) should be bolded. 



OIT Standards and Conventions v2.0 

Documentation Style Guide User Instructions 
November 2010 

48 

20.1.3 Keystrokes 
A key that the user is instructed to press (other than a letter, number, or symbol to be 
typed) is referred to using the word “press” before the key name. Capitalize the key 
name as it appears on the keyboard. Do not use any additional punctuation or 
formatting when referring to named keys. 

Example: Type the item number and press Enter. 

Example:

Use a hyphen (-) instead of a plus sign (+) to connect keystrokes that are performed 
simultaneously. If necessary, explain this notation in an Orientation section of the 
manual. 

 To move the cursor between fields, press Tab. 

Example

Use a comma and a space to separate keystrokes that are pressed in sequence. 

: Press Ctrl-D [press the Ctrl key and the D key simultaneously] 

Example

20.1.4 Caret (^) 

: Press Alt, I to open the Insert menu. [Press the Alt key, then release and 
press the I key.] 

In RPMS packages, the caret (^) has a navigational function and is referred to 
frequently in the manuals. The standard term for this punctuation mark is “caret,” 
although “up-hat” and “circumflex” may still appear in older documents and in 
RPMS training.  

Never refer to the caret as “the up-arrow.” 

When referring to the caret, always include the name (“caret”) and the symbol, with 
the symbol in parentheses. If the reference appears in a procedure step where the user 
is being instructed to type a caret, format the symbol in bold type within the 
parentheses. 

Problem: Type the up-arrow at the next prompt. 

Problem: Type the caret at the next prompt. 

Problem: Type the up-hat at the next prompt. 

Solution: Type the caret (^) at the next prompt. 
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20.2 Writing Procedures 

20.2.1 Introducing Procedures 
To introduce a series of procedural steps, use a complete sentence ending with a 
colon, and follow the same grammatical pattern for all such introductions in a 
document.  

Refer to Section 21.0 for more information on the structure of lists in procedures. 

Example

20.2.2 Describing User Input 

: To print the document, follow these steps: 

The characters that a user is instructed to type at a roll-and-scroll prompt or in a GUI 
control (for example, a text box) are indicated by bold type. Format bold type by 
applying the “Bold” character style in the document’s template.  

Example: Type PTRG at the main menu prompt. 

Example: Type your user name in the Name

Refer to Section 

 box. 

20.0 for more information on writing user instructions. 

Note: Do not use Ctrl-B or the “B

20.2.3 Describing User Selections 

” toolbar button to indicate user 
input. Text formatted using either of these methods is not 
compliant with Section 508 standards. 

Describe selections in the order the user makes them. 

Example: On the File menu, click Open. 

Example: In the Open dialog box, select the file you want to open and then click 
Open. 

Example: To print the report to a file, type Host or HFS at the “Home” prompt, then 
type the file location and name at the “HOST FILE NAME” prompt. 



OIT Standards and Conventions v2.0 

Documentation Style Guide User Instructions 
November 2010 

50 

20.3 Writing Instructions for Roll-and-Scroll Applications 

20.3.1 Referring to System Prompts 
Use double quotes around prompts in instructions and procedure steps. Use single 
quotes only within double quotes. Do not add quotes around prompts within a roll-
and-scroll text capture block. 

In instructions and procedure steps, do not edit prompts for grammar, spelling, or 
capitalization. Prompts must appear in instructions exactly as they appear on the roll-
and-scroll screen. 

If a prompt ends with a question mark, include the question mark within the quotation 
marks. However, do not

The word “prompt” must follow all references to prompts to distinguish them from 
other elements. When directing the user to type a response to a prompt, always 
include the prompt name. 

 include the ending colon when a prompt is referred to in an 
instruction or procedure step. 

20.3.2 Instructions for Responding to Prompts 
In general, instructions should include (1) the action the user should take (“type ZZZ 
and press Enter”

Always include the phrase “press Enter” in the instruction after describing the user 
input. 

); (2) the location where the action is taken (“at the ‘XXX’ prompt”); 
and (3) the result or goal of the action (“to display the AAA menu” or “a sorted list of 
providers is displayed”). The order of these elements depends on the desired structure 
of the individual procedure step or instruction. 

Example: To display the Patient Registration menu, type RPTG at the “Main 
Menu” prompt and press Enter. 

Example: At the “Main Menu” prompt, type RPTG and press Enter to display the 
Patient Registration

20.3.2.1 Default Responses to Prompts 

 menu. 

Prompts in RPMS are often followed by a default response. Default responses appear 
after the colon or question mark, if present, and are followed by two forward slashes. 
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In the following example, “C” is the default response to the “Create List/Sort by” 
prompt. 

  Select one of the following: 
 
     C         By CLINIC NAME for a specified appointment date range 
     P         Selected Patients w/Appointments 
     D         One Facility's or Divisions Appointments 
     A         Any selected set of patients regardless of appt 
status 
 
Create List/Sort by: C//   

Default responses are not uniform throughout RPMS and are not part of the actual 
prompt. Do not include the default response when referring to a prompt in an 
instruction or procedure step. 

Problem: Type P (Print) at the “Do you want to: B//” prompt. 

Solution: To print the report, type P

The default response to a prompt is accepted by pressing Enter. 

 at the “Do you want to” prompt. 

Example: 

20.3.3 Order of Instructions and Text Capture Blocks 

At the “Enter the Name of the Community Taxonomy” prompt, press 
Enter to accept the default taxonomy, or type the name of a taxonomy and press 
Enter. 

Instructions for roll-and-scroll applications often include specially formatted text 
blocks displaying the screen that appears at each step in a procedure.  

Whenever possible, place the instruction for responding to a specific system prompt 
after Figure 20-1 the text capture block that displays the prompt ( ). 

If an instruction refers to the screen displayed after responding to the prompt, place 
the instruction before the text capture of the next screen (if available). It is not 
necessary to refer to the next screen, but if the structure of the instruction allows, the 
phrase “as shown in the following example” is an acceptable way to do this (Figure 
20-1). 

Refer to Section 23.1 for information about formatting roll-and-scroll text capture 
blocks. 

20.3.4 Example of Instructions for Roll-and-Scroll Applications 
Figure 20-1 shows the correct order of text capture blocks and user instructions for a 
roll-and-scroll application, as well as the structure of some typical instructions. 
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1. At the “Select National GPRA & PART Reports Option” prompt, type SUM and 
press Enter to display the following information about the National GPRA & 
PART Clinical Performance Summaries Report. 

      IHS 2009 National GPRA & PART Report Clinical Performance Summaries 
 
This will produce ONLY the clinical performance summaries for the 
National GPRA & PART Report for the 2009 GPRA year.  If you want the 
detailed information included in the report, including performance measure 
definitions and number of patients in each denominator and numerator you 
need to run the GP menu option. 
 
You will be asked to provide the community taxonomy to determine which 
patients will be included.  This report will be run for the Report Period 
July 1, 2008 through June 30, 2009 with a Baseline Year of July 1, 1999 
through June 30, 2000.  This report will include beneficiary population of 
American Indian/Alaska Native only. 
 
You will NOT be able to export this data to the Area Office; use the GP 
menu option to export your data to the Area Office. 
 
Press enter to continue:  <Enter> 

Figure 5–3: Running the National GPRA & PART Clinical Performance Summaries 
Report: report description (Step 1) 

2. Press Enter to continue. 
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Checking for Taxonomies to support the National GPRA & PART Report... 
 
All taxonomies are present. 
 
End of taxonomy check.  PRESS ENTER: <Enter>  
 
Which Designated Provider: PROVIDER,DEMO <Enter> 

Figure 5–4: Running the National GPRA & PART Clinical Performance Summaries 
Report: checking taxonomies (Step 3) 

3. The system checks to see if all taxonomies required for this report are present and 
have members associated to them. At the prompt, press Enter to continue. 

4. At the “End of taxonomy check” prompt, press Enter to continue. 

5. At the “Which Designated Provider” prompt, do one of the following: 

• Type the name of the designated primary care provider you want to report on 
and press Enter. 

• Type the first few letters of a provider’s name and press Enter to see a 
selection of available providers beginning with those letters, or type two 
question marks (??) and press Enter to see the entire list. Then type the 
number of the provider you want to report on and press Enter. 

The hard-coded date ranges for this report are displayed, as in the following 
example: 

The date ranges for this report are: 
     Report Period:  Jul 01, 2008 to Jun 30, 2009 
     Previous Year Period:  Jul 01, 2007 to Jun 30, 2008 
     Baseline Period:  Jul 01, 1999 to Jun 30, 2000 

Figure 5–5: Running the National GPRA & PART Clinical Performance Summaries 
Report: displaying date ranges 

Figure 20-1: Example instructions for GUI application 

20.4 Writing Instructions for GUI (Windows-Based) Applications 
Refer to Microsoft Manual of Style for Technical Publications, 3rd Edition, for 
conventions and standards used to describe windows, dialog boxes, and the elements 
and controls they contain. Some general guidelines appear below. 
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20.4.1 Referring to Controls in Windows and Dialog Boxes 
• Use bold type when referring to window or dialog box titles; labels (names) of 

buttons, lists, text boxes, option buttons (also known as radio buttons), and other 
controls; menu names and options that can be selected from lists; and any other 
named element in a window or dialog box. 

• Use “click” (not “click on”) for menu commands, command buttons (e.g., the 
Open

• When instructing the user to click a button or option button, include the label of 
the button in the instruction, but do not include the word “button.” 

 button), option buttons, and options in a list. 

Problem: Click on the Open button. 

Solution: Click Open

• Use “select” and “clear” for checkboxes instead of “check” and “uncheck” or 
“deselect.” Include the label (name) of the check box and the words “check box” 
in the instruction. 

. 

Example: On the Line and Page Breaks tab of the Paragraph dialog box, select 
the Keep with next

20.4.2 Referring to Menu Options 

 check box to suppress a page break in the selected lines of 
text. 

All menu names and menu option names appear in bold type. 

When instructing the user to select a menu option, include (1) the name of the top-
level menu, (2) the name of the option to select, and (3) any subsequent options that 
must be selected after the first one. The order of these elements depends on the 
structure of the individual instruction. 

Example: On the Insert menu, click Break to display the Break dialog box. 

Example: To display the Break dialog box, click Break on the Insert

If a menu option has a submenu, instruct the user to “point to” the first menu option 
(it’s not necessary to “click” a menu option to open a submenu) and to “click” the 
option in the submenu.   

 menu. 

Example: On the Insert menu, point to Reference and then click Caption to display 
the Caption dialog box. 

Example: To add a caption to a figure, point to Reference on the Insert menu and 
then click Caption. 
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20.4.3 Instructions for GUI Applications 
In general, instructions should include (1) the action the user should take (“click 
Open”); (2) the location where the action is taken (“in the Open dialog box”; “on the 
File menu”); and (3) the result or goal of the action (“the selected file is opened” or 
“to open a file”). The order of these elements depends on the desired structure of the 
individual procedure step or instruction. 

Example: In the Facilities window, click Add All to select all sites and add them to 
the Selected Items list. 

Example: To upload the selected files, click Upload Checked Files

20.4.4 Example of Instructions for GUI Applications 

 at the top of the 
window. 

Figure 20-2 shows instructions for using window controls in a GUI application, as 
well as the structure of some commonly used instructions. 
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1. To select a provider for the report, click Select next to the Provider box to 
display the Provider window. 

Figure 5–1: Provider window 

Available providers will appear in the Provider list (the left pane) after you 
complete Step 2. If a provider has been selected, it will appear in the Provider 
Selected list (the right pane) after you complete Step 3. 

Note: Although multiple providers can appear 
simultaneously in the Provider Selected pane, 
a report can be run for only one provider at a 
time. 
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2. To locate a specific provider, follow the steps below. 

a. To display a list of providers, do one of the following 

• To display the entire list of providers, leave both the Begin String and the 
End String boxes blank. 

Note: The entire list of providers may be very long. 

• To display a filtered list of providers, follow the instructions in Filtering 
Lists. 

b. In the Number of Records list, select the number of providers to display at 
one time. 

c. Click Search. 

d. To view additional providers with the same criteria, click More. (If all 
providers with the specified criteria are already displayed in the Provider list, 
the More button is unavailable.) 

3. Scroll through the Provider list to locate the provider you want to use. Click the 
provider to highlight it, and then click Remove to move it to the Provider 
Selected list. 

To remove a provider from the Provider Selected list, click the provider to 
highlight it, and then click Add to move it back to the Provider list. 

4. When you have selected the correct provider for the report, click Save to close 
the window and save the provider selection. 

To close the Provider window without saving your selection, click Close. 

Figure 20-2: Example instructions for GUI application 
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21.0. Lists and List Items 

21.1 Numbered vs. Bulleted Lists 
Use a numbered list only if the list items must be read or completed in a particular 
order (such as steps in a procedure), or if the numbering is critical to understanding 
the list or items. 

Use a bulleted list when there is no explicit reason to use a numbered list. 

If a list has only a single item, format it as a standard paragraph instead of a list. The 
only exception is the case of a procedure with a single step. If a procedure has only a 
single step, use a bullet instead of a number. 

Example: 

• 

Closing the application 

21.2 

To close the application, click Quit. 

21.2.1 Styles for Numbered Lists 

Styles for Lists 

OIT templates for application-related documents include two types of styles for 
numbered lists. 

• The “ListNum” style, which uses Word’s autonumbering function, is useful for 
simple, single-level lists. However, this style can cause problems in a document 
with multiple lists when the numbering must start over at “1” for each list. 

• The “Number” style is a paragraph style with a hanging indent that does not auto 
number. Instead, the correct number, followed by a period and a tab, must be 
typed for each list item. 

For more information or assistance with the use of styles for numbered lists, contact 
the OIT Documentation Team. 

21.2.2 Styles for Bulleted Lists 
Templates for RPMS documents contain a series of bullet styles (“Bullet1” through 
“Bullet3”) and a series of styles with en dashes (“–”) used as bullets (“Dash1” 
through “Dash3”). The “Bullet1” and “Dash1” styles are set at the left margin of the 
“bdytxt1” style, while the “Bullet2” and “Dash2” styles correspond to the “bdytxt2” 
style. 
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Do not

21.3 

 use open bullets, wingdings, or graphical bullets under any circumstances. 
Open bullets and wingdings cannot be made 508 compliant. 

At times, it is necessary to include sublists within individual list items. Make the 
sublists bulleted or numbered following the guidelines in Section 

Nested Lists 

21.1. Use the 
following hierarchy of numbers and letters for ordered lists in general text. 

1. xxxx 

A. xxxxx 

i. xxxxx 

a. xxxxx 

Use the following hierarchy of numbers and letters in user instructions and procedure 
steps. Rewrite procedures that require more than three nested levels. 

1. xxxx 

a. xxxxx 

i. xxxxx 

Use the following hierarchy of bullets and dashes for nested bulleted lists. 

• xxxx 

− xxxx 
• xxxxx 

– xxxxx 
Follow all other list guidelines for nested lists. Avoid nesting lists more than three 
levels whenever possible. 

21.4 Paragraph Lists 
If list items can be incorporated into a sentence, it is unnecessary to format them as a 
vertical list. In this case, introduce each list item with a number in parentheses.  

“Lists may be either run into the text or set vertically, in outline 
style. Short lists are better run in, and lists that require typographic 
prominence or are extremely long, or that contain items of several 
levels should be set vertically.” {The Chicago Manual of Style 
(15th Edition)} 

List items in a paragraph are separated with commas or semicolons. If one or more of 
the individual list items includes a comma, use semicolons to separate the items.  
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Example: Before submitting your resume, be sure that you’ve included (1) your 
name, (2) your phone number, and (3) your e-mail address. 

Example: 

21.5 Introducing Lists and Procedures 

The application package should include (1) your resume, including your 
name, phone number, and e-mail address; (2) a cover letter; and (3) the application 
form, including any attachments. 

Always introduce a list or procedure with a complete sentence followed by a colon. 

• Do not introduce a list with a sentence fragment. 

• Do not structure a list so that list items form a complete sentence beginning with 
an introductory fragment. Revise the list or convert it to a paragraph list (Section 
21.4). 

Problem

In the 

: 

Properties

• length. 

 dialog box, set: 

• height. 

• width. 
In the Properties

• length, 

 dialog box, set: 

• height, and 

• width. 

Solution

In the 

: 

Properties

• Length 

 dialog box, set the following parameters: 

• Height 

• Width 
Refer to Section 21.6.2 for information about periods and other punctuation in list 
items. 
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21.6 List items 

21.6.1 Parallel Structure 
All list items should be structured the same way; for example, each item should be an 
instruction, a single word, a gerund phrase, a complete sentence, etc., depending upon 
the context. Rewrite items to be parallel in structure if necessary. 

Note: In very rare situations, parallel list structure is simply not 
possible. However, leaving a list with nonparallel list items 
should be an absolute last resort. 

Problem

The assistant is responsible for the following tasks: 

: 

• Feeding elephants 

• Washing elephants 

• They will also train elephants to stand on a small box 
Solution

The assistant is responsible for the following tasks: 

: 

• Feeding elephants 

• Washing elephants 

• Training elephants to stand on a small box 

21.6.2 Punctuation 
List items carry no punctuation unless they consist of complete sentences. 

If one item in a list is a complete sentence that stands alone (including an instruction), 
put a period at the end of every item in the list. However, the preferred approach is to 
revise the list items to make them parallel (i.e., all items are complete sentences or no 
items are complete sentences. Refer to Section 21.6.1 for details.) 

Examples

• 

:  

In the 
No complete sentences 

Properties

• Length 

 dialog box, set the following parameters: 

• Height 

• Width 
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• 
To set parameters in the 
All items complete sentences 

Properties

• Set Length to the distance from the front to the back of the item. 

 dialog box, follow these guidelines: 

• Set Height to the distance from the top to the bottom of the item. 

• Set Width to the distance from the left to the right of the item. 

21.6.3 Capitalization 
Capitalize the first letter of the first word in each list item, regardless of whether the 
item is a complete sentence. 

21.6.4 List Items with Introductory Words or Phrases 
When list items consist of an introductory word or phrase combined with a longer 
description, the introductory text is capitalized, formatted in bold, and followed with 
a period. The descriptive text is formatted in default paragraph text, and all other rules 
for list items apply (parallel structure, capitalization, punctuation). 

In a list with introductory words or phrases, each item should have the same structure 
of introductory words. 

Examples

In the 

:  

Properties

• 

 dialog box, set the following properties: 

Length.

• 

 The distance from the front to the back of the item 

Height.

• 

 The distance from the top to the bottom of the item 

Width.

In the 

 The distance from the right to the left of the item 

Properties

• 

 dialog box, set the following properties: 

Length.

• 

 The length is the distance from the front to the back of the item. 

Height.

• 

 The height is the distance from the top to the bottom of the item. 

Width. The width is the distance from the right to the left of the item.  
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22.0. Figures, Text Captures, and Tables: General 
Guidelines 
OIT documents can contain a variety of figures and tables with different formatting 
and style requirements. Documentation for RPMS roll-and-scroll (non-GUI) 
applications contains text captures of terminal screens, while documentation for GUI 
applications contains screen captures of application windows. 

General guidelines for figures and tables appear in this section, including guidelines 
for captions, in-text references, and callouts. Specific guidance for tables and 
different types of figures appears in the sections that follow. Please contact the OIT 
Documentation Team with questions about figures and tables that are not addressed in 
this and the following sections. 

22.1 Formatting 
Roll-and-scroll text capture blocks are formatted by applying one of the computer 
output styles (“computer output,” “Computer Output,” or “computer screen”) 
available in RPMS templates. For more information, refer to Section 23.1. 

Most RPMS templates include a “Picture” style. Apply this style to all figures to 
ensure proper placement and spacing. For information about formatting figures, refer 
to Section 23.2.2. 

22.2 Size and Placement 
Figures and tables must be sized to fit within the printed margins of the page. 
Whenever possible, they should match the left margin of the main body text style 
used in the document (“bdytxt1” in most RPMS templates). This may require resizing 
table columns or, for images, resizing a graphic file in Visio or another image editing 
application to maintain the image resolution.  

The maximum width of an item that fits between the left margin of “bdytxt1” text and 
the right margin of the document is 5.8 inches. 

If one of the computer output styles has been applied to a roll-and-scroll text capture 
block, it is sized correctly.  

22.2.1 Using Landscape-Oriented Pages 
If a figure or table cannot be made narrow enough for a portrait-oriented page, it is 
acceptable to place it on a landscape-oriented page. 
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Note:

22.2.2 Location of Figures and Tables  

 Inserting a landscape page in a portrait-oriented document 
is complex and requires adding section breaks and revising 
headers and footers. If you encounter problems with this 
process, contact the OIT Documentation Team for 
assistance. 

A figure or table should be placed after its first reference in the text. Refer to Section 
22.4 for information on in-text references to figures and tables. 

Figures and tables should not be placed against each other without text as a buffer, 
unless they represent consecutive pages of a screen or report and there is no text to 
place between them. In this case, the caption for each consecutive figure should 
include the notation “x of y” (e.g., Figure 12–1: Patient report, Screen 1 of 5). 

22.3 Captions and Table Titles 
Every figure and table, including roll-and-scroll text capture blocks, must have a 
caption or table title. The caption or title is a brief description of the contents of the 
figure or table. A figure caption is placed under the corresponding figure, while a 
table title is placed above the corresponding table. 

Figure captions and table titles consist of the word “Figure” or “Table” followed by 
(1) the figure or table number, a colon, and a single space; and (2) the caption or title 
text. Caption and title text is set in sentence case with no ending period. 

To create figure captions and table titles, use Word’s Caption
22.3.1

 dialog box (Section 
). This ensures that figure and table numbers are ordered correctly if figures or 

tables are rearranged, added, or deleted, and that in-text references linked using 
Word’s cross-reference function (Section 22.4.1) remain correct as well.  

Most RPMS templates include several styles for figure captions and table titles. The 
Caption

22.3.1 Using Word’s Caption Dialog Box 

 dialog box automatically sets both figure captions and table titles to the 
“Caption” style, so table titles must be changed to the “Table Title” style after being 
created. 

1. To display the Caption

• Right-click on a figure and click 

 dialog box, do one of the following: 

Insert Caption

• Select an entire table. Right-click the selected table and click 

. 

Insert Caption

• Position the cursor inside or above a table, or inside or below a figure. On the 

. 

References tab, click Insert Caption. 
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• Position the cursor below a roll-and-scroll text capture block. On the 
References tab, click Insert Caption

2. In the 

. 

Label list, select Figure or Table

3. In the 

. 

Caption box, ensure that the section number and the figure number appear 
separated by a hyphen, with no spaces surrounding the hyphen. 

Example:

If the section number and figure number are not present, or if they appear 
separated by a different character, click 

 Figure 23-4 

Numbering and ensure that the settings 
in the Caption Numbering Figure 
22-1

 dialog box are the same as those shown in 
. Click OK. 

 
Figure 22-1: Caption Numbering

3. In the 

 dialog box showing correct settings 

Caption

4. Click 

 box, type a colon and a space following the figure number, and 
then type the text for the figure caption or table title. 

OK

22.4 In-Text References 

. 

Always introduce a figure or table with a reference in the text before the figure or 
table appears in the document. (In-text references are sometimes referred to as 
“callouts.”) Section 22.4.1 has instructions on using Word’s cross-reference function 
to link the in-text reference to the figure or table number. 

• Do not include the text of the caption or table title in the in-text reference. 

• Do not refer to figures or tables by their physical location in the document (e.g., 
“the figure below”). 
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• Do not include the word “see” in in-text references unless the reference is outside 
parentheses and the flow of text requires its inclusion. Only capitalize the word 
“figure” if it is at the beginning of sentence, or a direct figure reference. 

22.4.1 Inserting a Cross-Reference (In-Text Reference) to a Figure 
Caption or Table Title 
1. On the Insert tab, click Cross-reference

2. In the 

. 

Reference type list, select the type of cross reference you want to link to 
(e.g., Figure or Table

3. In the 

). 

Insert reference to list, select Only label and number

4. Leave the Insert as Hyperlink check box selected. 

. 

5. In the For which caption

6. Click 

 list, select the figure or table to be referenced. 

Insert

22.5 Alternate Text (Alt Text) 

. 

For compliance with Section 508, every image and graphic element in a document 
must have alternate text (“alt text”) associated with it. 

Alt text in a 508-compliant document is intended to provide an equivalent experience 
of the document for individuals using screen readers or who are otherwise unable to 
see images. Be aware of the different needs of the document’s various audience 
members when composing alt text. 

Alt text must be added to (1) images placed as pictures in Word; (2) logos; graphics, 
charts, and graphs in PowerPoint presentations; and (3) any other graphic element 
that is not read as text by a screen reader. This includes inline images of icons in 
documentation for GUI applications. 

To place an image in Word, follow the instruction in Section 23.2.2. 

To add alt text to a figure, follow these steps:  

1. Right-click the figure and click Format Picture

2. On the 

.  

Web tab, type the alt text in the Alternative Text

Alt text is not required for roll-and-scroll text capture blocks. Text capture blocks are 
formatted as text using the “computer screen” style in RPMS templates and can be 
read as text by a screen reader. 

 box. 
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22.6 Callouts or Labels 
Callouts are labels used to point out specific features in figures and occasionally in 
roll-and-scroll text capture blocks. Callouts often appear in a thin border and usually 
include a line with an arrowhead (a callout line) linking the text box to the specific 
feature. 

Use sentence-style capitalization in callout text (Section 17.0), or match the 
capitalization of the features being called out. 

22.6.1 Creating Callouts on Figures 
To create callouts on a figure, export the figure to Visio or another graphic design 
application. Type the callout text and apply a thin border to the text object. Try to 
position the callout so it is not covering important information; if possible, position it 
in a blank area of the figure. 

Add callout lines using Visio’s line and arrow features. Refer to Section 22.6.3 for 
guidelines on creating callout lines. 

When all callouts have been created, group the figure with the callouts and callout 
lines as described in Section 22.6.4 and save the revised figure as a GIF or TIFF file. 
Replace the figure in the original document with the new file as described in Section 
23.2.2. 

Note: Do not use the text box function in Word to create callout 
text boxes. Callouts created in Word’s text boxes cannot be 
made 508-compliant. 

22.6.2 Creating Callouts on Roll-and-Scroll Text Capture Blocks 
Callouts are added to text capture blocks in Visio using the same technique as for 
figures, which converts the formatted text to a figure. As noted in Section 22.5, all 
figures in 508-compliant documents must include alt text.  

For this reason, avoid adding callouts to roll-and-scroll text capture blocks unless it is 
absolutely necessary. Describe items in paragraph text instead. 

Do not use colored text to highlight specific features in text capture blocks. Colored 
text cannot be made 508-compliant and will be removed when the document is 
remediated. 
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22.6.3 Callout Lines 
To visually link callout text with the section of the figure it applies to, use straight 
horizontal and vertical lines whenever possible; diagonal lines will appear jagged. 
Straight callout lines may be difficult to see if they closely parallel the lines around 
the screen capture.  

Keep callout lines as simple as possible; try to restrict them to a single straight line. If 
this is not possible, create two lines that meet at a perpendicular angle. Do not create 
callout lines that fold back on themselves. Callout lines should have an arrowhead on 
the end closest to the area that the callout refers to. All arrows should point from the 
callout text box to

22.6.4 Grouping Figures with Callouts  

 the related location in the figure. 

For compliance with Section 508 standards, figures and text capture blocks with 
callouts or multiple components must be grouped and saved as a single image file. 
Use the following steps to perform this task in Visio. 

1. In the Word document, draw a selection box around the figure or text capture 
block, including all callouts, callout lines, and separate components, and copy the 
selection. 

2. Paste all components into a new document in Visio. 

3. To group the components, be sure they are all selected and right-click the image. 
On the context menu, point to Shape, and then click 

4. To save the grouped image as a GIF file, follow these steps: 

Group. 

a. Point to Save As on the File
b. Navigate to the folder where the figure is being saved. In the 

 menu. 

Save as type list, 
select either Graphics Interchange Format (*.gif) (typically used to save 
line art) or JPEG Interchange Format (*.jpg) (typically used to save 
photographic images), and then type the file name in the File name 

c. Click 

box. 

Save
5. In the Word document, replace the original figure by deleting the figure and all of 

its callout components, and then following the instructions in Section 

. 

23.2.2. 
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23.0. Figures 

23.1 Roll-and-Scroll Text Capture Blocks 
The text in a roll-and-scroll screen can be captured using a variety of methods 
(PrintScreen, copy and paste, a terminal output capture utility, etc.). 

When a block of captured text has been placed in a document, it must be formatted 
using the “Computer Output,” “computer output,” or “computer screen” style. Each 
of these styles converts the font to Courier New and adds a shaded background and a 
box around the captured text (Figure 23-1).  

The three styles are formatted with different margins and spacing. Choose the style 
that best fits your text captures and document. 

2009 CRS TAXONOMY UPDATE      Jun 05, 2009 16:12:58          Page:    1 of    1 
TAXONOMIES TO SUPPORT 2009 NATIONAL GPRA REPORT REPORTING 
 
 
1)  BGP CMS SMOKING CESSATION MEDS   DRUGS 
2)  BGP GPRA ESTIMATED GFR TAX       LAB         Estimated GFR Lab Tests 
3)  BGP GPRA FOB TESTS               LAB         Fecal Occult Blood Lab Tests 
4)  BGP HIV TEST TAX                 LAB         HIV Screening Lab Tests 
5)  BGP PAP SMEAR TAX                LAB         Pap Smear Lab Tests 
6)  BGP QUANT URINE PROTEIN          LAB 
7)  DM AUDIT HGB A1C TAX             LAB         Hemoglobin A1C Lab Tests 
8)  DM AUDIT LDL CHOLESTEROL TAX     LAB         LDL Cholesterol Lab Tests 
 
 
          Enter ?? for more actions                                          >>> 
S    Select Taxonomy to Edit            Q    Quit 
D    Display a Taxonomy 
Select Action:+//   

Figure 23-1: Example of a roll-and-scroll text capture formatted using the “computer output” 
style 

A roll-and-scroll text capture block requires a caption like other figures. If the 
captured screen is associated with a procedure step, the caption should refer to the 
step number. Refer to Section 22.3.1 for instructions on creating captions for text 
capture blocks. 

Because text capture blocks are formatted as text and can be read by screen readers, 
they do not require alt text. However, if callouts are added to a text capture block, the 
callouts and the text capture block must be exported to Visio and converted to a 
figure as described in Section 22.6.2. When pasted into the document, the resulting 
figure would require alt text. 
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Do not edit the text in roll-and-scroll text capture blocks. The text capture displayed 
in the document must match the screen the user sees exactly, including errors in 
spelling, punctuation, capitalization, and sentence structure. 

Note:

23.1.1 Hard Returns in Roll-and-Scroll Text Capture Blocks 

 Column width and spacing in reports formatted for the roll-
and-scroll terminal may not be correct when the reports are 
formatted as text. This is the only situation where text in 
text capture blocks should be edited. To avoid problems 
with tab settings, use spaces rather than tabs to realign the 
columns. 

Because large numbers of hard returns may interfere with generating a Section 508-
compliant PDF, OIT practice is to replace all hard returns within text capture blocks 
(except the final hard return in the block) with soft returns.  

To insert a soft return, press Shift-Enter. 

To automate this process using the Find and Replace

1. Type 

 dialog box, follow these steps: 

^p (“caret p”) in the Find what box and ^l (“caret l”) in the Replace with

2. Position your cursor at the top of the text capture block and click 

 
box.  

Replace 
repeatedly until all hard returns except the last one in the block

(

 have been 
replaced. 

Do not click Replace All unless you are certain you have selected only

23.2 GUI/Windows-Based Screen Captures 

 the text in 
the text capture block; otherwise you will replace all the hard returns in the entire 
document, which is probably not what you intended to do!) 

Use a utility like Snagit to capture images of Windows-based screens. For the best 
combination of resolution and file size, save images in GIF format. 

Do not edit screen captures; they must exactly match what the user sees when using 
the application. If the application was under development while the documentation 
was being written, check screen captures against the final build of the application. 
Replace screen captures with updated images if necessary. 

For Section 508 compliance, every image in a document must have alt text associated 
with it. To add alt text to an image, right-click the figure and click Format Picture. 
On the Web tab, type the alt text in the Alternative Text box. 
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23.2.1 Size of Images 
The maximum width of an image that fits within the text margins of an OIT 
document is 5.8 inches. Adjust the size when creating and saving the image, or use 
the Size tab of the Format Picture

23.2.2 Placing and Formatting an Image in Word 

 dialog box to resize the image after it has been 
placed in Word. Be sure to adjust both the height and the width by the same 
percentage to maintain the aspect ratio and avoid distortion. 

1. Insert a carriage return in the document at the location where the image is to be 
placed. 

2. Select the carriage return and apply the “Picture” style found in an RPMS 
template. 

3. With the carriage return still selected, point to Picture on the Insert tab, and then 
click From File

4. In the 

. 

Insert Picture dialog box, navigate to the folder where the image is stored. 
Select the image and then click Insert

23.3 Other Images  

. 

Use the steps in Section 23.2.2 to insert images from other sources into Word 
documents. Set the size correctly and add alt text to all images. 

Before placing an image, be sure it is a single, flattened (grouped) image.  

• If an image is composed of multiple smaller images, use the steps in Section 
22.6.4 to group the components into a single image.  

• If an image is composed of multiple layers, use an image processing application 
to flatten the layers. 

23.4 HHS and IHS Logos 
The Department of Health and Human Services (HHS) and Indian Health Service 
(IHS) logos must be included on the covers of all documentation. These logos should 
be of equal size and are placed only on the title page. 

Each RPMS template contains a correctly formatted title page that includes the IHS 
and HHS logos correctly placed with the rest of the title page elements. 

As described in Section 4.1.1, the correct use of an RPMS template is to save the 
template as a new document and then add text to that document. This preserves the 
title page from the template, making it unnecessary to create a title page from scratch.  
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Be sure to replace the dummy text on the title page with the content for the specific 
RPMS package and document. 

23.5 Image Accents 
Do not use decorative images to convey information types. For example, many older 
RPMS manuals include a small book-and-pen graphic next to notes. In addition to 
requiring alt text for every instance, this type of icon is a distraction and 
unnecessarily enlarges the file. 

Use the “notes” and “Warning” styles available in RPMS templates for notes and 
warnings instead.  

Examples: 

Note: To format a note, type the note text beginning with the 
word “Note” followed by a colon and a tab. Apply the 
“notes” style to the text, and then apply the Bold character 
style to the word “Note.” 

Warning: To format a warning, type the warning text beginning 
with the word “Warning” followed by a colon and a single space. 
Apply the “Warning” style to the text, and then apply the Bold 
character style to the word “Warning.” 
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24.0. Tables 
For Section 508 compliance, formatting must be applied to tables so that screen 
readers can interpret the data correctly. 

Avoid merged cells and the use of tables for layout purposes except when creating 
forms and acronym lists. 

24.1 Size and Placement of Tables 
Tables must be sized to fit within the printed margins of the page. Edit the column 
width if necessary. 

While a table may occupy the entire width of the page from margin to margin, it is 
preferable to position the left border of the table at the left margin of the document’s 
body text.  

• To place a table at the left margin of text formatted using the “bdytxt1” style 
(found in OIT application-related document templates), type 0.8″ in the Indent 
from left box on the Table tab of the Table Properties

If the columns cannot be made narrow enough to fit the table on a portrait-oriented 
page, it is acceptable to place it on a landscape-oriented page. Contact the OIT 
Documentation Team for assistance or information. 

 dialog box. 

Note:

24.2 Formatting Tables 

 Inserting a landscape-oriented page in a portrait-oriented 
document requires the addition of extra section breaks, but 
adding section breaks to a document based on an OIT 
document template may cause problems with headers and 
footers. If you encounter problems with this process, 
contact the OIT Documentation Team for assistance. 

To ensure that the data and the heading row or rows in a table can be interpreted 
correctly by a screen reader, the table must be tagged by applying the “Table Grid” or 
“Table Normal” style. Refer to Section Error! Reference source not found. for 
instructions.  

If a table spans one or more page breaks, the heading row or rows must appear at the 
top of each page.  

Table rows must not be allowed to break across pages, because a screen reader cannot 
associate table data with the correct column or row headings. 
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24.2.1 Other Table Formatting 
• Format the heading row and table cells with the correct styles in the RPMS 

template (TableHeadCtr or TableHeadLeft for heading rows, and TableTextL, 
TableTextM, or TableText for all other table cells). 

Bulleted and numbered list styles for text in table cells (tBullet1, tNumber, etc.) 
are also available in RPMS templates. 

• Set the heading row or rows to repeat if the table breaks across pages.  

− Select the rows to repeat on each page.  
− On the Row tab of the Table Properties dialog box, select the Repeat as 

header row at the top of each page
• Set all table rows to 

 check box. 
not

− Select the entire table. 

 break across pages.  

− On the Row tab of the Table Properties dialog box, clear (uncheck) the 
Allow row to break across pages 

24.3 Color 

check box. 

Color is frequently applied to table header rows and other table cells; however, as 
stated in Section 3.1.1, the use of color in 508-compliant documents must be limited 
or avoided. 

The “TableHeadCtr” and “TableHeadLeft” styles available in RPMS document 
templates use bold type, which is sufficient to set off the header rows in most tables. 
If absolutely necessary, it’s acceptable to use a very lightly shaded, neutral 
background for table header rows, but even light shading can cause problems for 
some colorblind individuals. Use the table header row styles instead whenever 
possible. 
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25.0. Word Usage 

25.1 General Guidelines 
• Define new terms that are not listed in a regular dictionary the first time they 

appear in the text, and include these terms in the glossary as well. 

• Do not use slang or undefined jargon. 

• Do not use terms that have several different meanings. 

• Use defined terms consistently throughout the documentation. Do not use 
synonyms. 

• Ensure that all spelling is correct. 

• Avoid general adjectives that can be misinterpreted. For example, “the user-
friendly Windows desktop” could mean that either the desktop is user-friendly or 
that Windows is user-friendly. 

25.2 Humanization of Computers 
Do not humanize computers or computer interactions. Do not apply emotions, desires, 
or opinions to software programs or computer systems, and do not apply a sense of 
location or dimension to a software application. For example, the user cannot be “in” 
a text editor. 

Problem: The machine remembers your choices. 

Solution: The machine stores your choices. 

Problem: The computer asks you for the current site name. 

Solution: The computer prompts you for the current site name. 

Problem: The system tells you what options to choose from. 

Solution: The system displays a list of options to choose from. 

Problem: The user will be in the text editor. 

Solution: You can update the text with the text editor function. 

Solution: You can update the text in the text editor window. 

Solution: The text editor application is active. 
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25.3 Latin Terms 
Commonly used Latin and Latinate terms such as “i.e.” and “e.g.,” do not appear in 
italics. Less common terms, such as “a priori,” “et al.,” “pro bono,” and “quid pro 
quo

25.4 Gender 

” should be italicized. 

Use plurals or specific descriptions to avoid “he,” “she,” “he or she,” “s/he,” and “it.” 
If a plural subject is used to avoid a specific gender, be sure that the entire sentence or 
statement is in agreement with the plural subject.  

Problem: The programmer writes code. He then compiles it. 

Solution: The programmer writes code and then compiles it. 

Solution

If it is not possible to avoid referring to gender, use an appropriate plural or the 
complete statement “he or she.” 

: Programmers write code. They then compile it. 

Problem: The system prompts the user for a site name. The user must type the name 
of their current site. 

Solution: The system displays a prompt for a site name. Users must type the name of 
their current site. 
Solution: The system prompts the user for a site name. The user must type the name 
of his or her current site. 

Solution:

25.5 Noun Strings 

 The system prompts the user for a site name. The user must type the name 
of the current site. 

Avoid noun strings. If a sentence cannot be rewritten to eliminate a noun string, 
hyphenate the words that are used as adjectives to aid comprehension. Never use a 
hyphen after an adverb ending in -ly. 

Example: UNIX-based workstation, end-user access, newly acquired software 

Problem: Underground mine worker safety protection procedures development 

Solution: Developing procedures to protect the safety of workers in underground 
mines. 
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25.6 Placement of “Only” 
Place the word “only” with the part of the sentence it modifies. 

Problem: We only lack financial backing; we have determination. 

Solution:

25.7 Possessive Form of Nouns Ending In “S” 

 We lack only financial backing; we have determination. 

If a singular noun ends with an “s”, create the possessive form by adding an 
apostrophe and “s”. 

Example

25.8 Trademarks 

: Dr. Seuss’s books 

Use trademarked terms as adjectives, not nouns. Mark the first instance of a 
trademark in the front matter and in the body of the document, and omit the 
trademark symbol in subsequent mentions. 

Example: The Widget (TM) product offers... never Widget offers... 
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26.0. Usage and Terminology 
This section contains definitions of general computer and RPMS-related terms, as 
well as usage guidelines for these and other frequently misused and misspelled words 

Use standard American English spelling rules, referring to the Merriam Webster 
Collegiate Dictionary (hard copy or online) for words not addressed in this section. 
Refer to the Microsoft Manual of Style for Technical Publications

20.3
 for styles and 

conventions generally used in documenting user interfaces, and Sections  and 
20.4 of this style guide for specific guidelines for OIT documentation. 

26.1 A 

26.1.1 Access 
“Access,” when used as a verb, is usually too general. Use a more specific word 
instead. 

Problem: Access the application. 

Solution

26.1.2 Affect  

: Start the application. 

“Affect” is generally used as a verb. Refer also to Effect. 

Example

26.1.3 Allow 

: Changing weather affects my sinuses. 

Avoid using “allow” when referring to software features; “allow” implies permission 
as opposed to capacity, capability, or functionality. Either rewrite the sentence or use 
the word “enable.” 

Problem: The software allows you to adjust the color of a photo. 

Solution: Using the software, you can adjust the color of a photo. 

Solution

26.1.4 Among vs. Between 

: This function enables you to adjust the color of a photo. 

Use “between” when referring to two things. 

Example: I could not decide between this and that. 
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Use “among” when referring to three or more things. 

Example

26.1.5 Appears (Verb) 

: I could not decide among all the choices. 

Do not use “appears” to describe items displayed by the software (windows, lists, 
menus, etc.) in response to a user action such as clicking a button. Use the phrase “is 
displayed” instead, or rewrite the sentence. 

Problem: Click Add New Measurement. The Add New Measurement dialog box 
appears. 

Solution: Click Add New Measurement. The Add New Measurement dialog box is 
displayed. 

Solution (preferred): Click Add New Measurement to open the Add New 
Measurement dialog box. 

Exception: “Appears” is acceptable when describing the location of a particular 
feature within a window or screen. 

Example: The EHR toolbar always appears at the top of the PATIENT CHART

26.2 B 

 
tab. 

26.2.1 Backup, Back Up  
The noun or adjectival form, “backup,” is one word. A “backup” is a copy of a 
resource made as a precaution in case the original resource is lost. Do not use 
“backup” as a verb.  

The verb form, “back up,” is two words with no hyphen. To “back up” files is to copy 
them to another location as a precaution in case the original files are lost. Do not use 
“back up” as a noun or adjective.  

26.2.2 Blank 
When no information is present in a field, refer to the field as “blank.” Do not use 
“empty” to refer to a field. 

26.2.3 Bring Up (Verb) 
Do not use “bring up.” Use “display” or “open” instead. 
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Example: Open the Add New Measurement dialog box. 

Example: Click New Style to display the New Style 

26.3 C 

dialog box. 

26.3.1 Canceled 
Use “canceled”, not “cancelled”  

26.3.2 Cascading Menu  
(GUI only) 

Use “submenu” instead of “cascading menu.”  

26.3.3 Cannot 
“Cannot” is always one word with no apostrophe. It is not a contraction. 

26.3.4 Check Box 
(GUI only) 

“Check box” is two words with no hyphen. 

In user instructions, use “select,” “click,” or “clear” to describe the action of selecting 
a check box. Do not use “check” or “uncheck.” Always include the name of the 
option associated with the check box and the words “check box” to identify this 
control. 

Definition: A square box associated with a user-selectable option. When selected, the 
box may be filled, checked, contain an “x,” or appear pushed in. Check boxes may be 
grouped together in a box with a title. In general, more than one check box can be 
checked at a time. (Refer also to Option Buttons. Note: In some systems, option 
buttons can be styled to look like check boxes.) 

Problem: Check Clear All Change Bars. 

Problem: Uncheck the Clear All Change Bars box. 

Solution: Select the Clear All Change Bars check box. 

Solution: Click the Clear All Change Bars check box. 

Solution: Clear the Clear All Change Bars check box. 
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26.3.5 Choose 
Avoid using the word “choose.” “Select” is usually more concise. 

Example

26.3.6 Clear, Clearly 

: Select the menu option that best describes your file. 

Words like “simply,” “obviously,” and “clearly” can seem condescending in some 
contexts. It’s important to pay attention to the tone of the document and use these 
words appropriately. 

26.3.7 Click (Verb) 
(GUI only) 

“Click” means to press and release the left mouse button once on an item. (Refer also 
to Right-Click, Double-Click) 

Use “click” to describe the action of selecting a control or item in a window with the 
left mouse button. Do not use the word “on” with “click.” 

Example: Click New Style to display the New Style dialog box. 

Example: Click OK. 

Example

26.3.8 Close 

: To hide a panel, click the panel’s hide button. 

(GUI only) 

“Close” means to remove a window, dialog box, or user interface component from 
the desktop.  

Use in conjunction with “display” and “open.” Do not use “quit” in this context.  

Example: To close a window, select Close on the File menu. 

Example: Click Cancel

26.3.9 Collapse 

 to close the dialog box. 

(GUI only)  

Closing an open item in a tree structure is referred to as “collapsing” the item. Items 
in tree structures are typically collapsed by double-clicking the item or by clicking the 
minus sign (-) or arrow icon beside the item.  
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Example

26.3.10 Comprise vs. Compose 

: To collapse a menu in the menu tree view, click the minus sign (-) beside 
the menu item. 

“To comprise” means “to be made up of,” “to consist of,” or “to include.” 

Example:

“To compose” means “to make up, to form the substance of something.” 

 The United States comprises fifty states. 

Example:

The phrase “is comprised of” is incorrect. Use “is composed of” or “consists of” 
instead. 

 The United States is composed of fifty states. 

Problem: The United States is comprised of fifty states. 

Solution:

26.3.11 Computed Field 

 The United States consists of fifty states. 

(RPMS) 

A computed field in an RPMS application displays a value generated by performing 
one or more operations on values in other fields.  

26.3.12 Configure vs. Modify 
“Configuring” is typically a large-scale activity. By contrast, “modifying” is a 
smaller-scale activity. For example, you usually use the term “configure” to refer to 
specifying settings for the entire desktop or for an application such as a database. 
Refer also to Modify. 

Example: To configure your desktop, right-click an open space on the desktop. 

Example: Modify the background color through the Properties

26.3.13 Contains 

 dialog box. 

Use “includes” instead of “contains.” 

26.3.14 Context Menu 
(GUI only) 

The context menu is displayed by right-clicking an item. Do not use “right-click 
menu.” 
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Problem: Right-click the selected item to display the right-click menu. 

Solution:

26.3.15 Co-Pay 

 Right-click the selected item to display the context menu. 

“Co-pay” is one word, hyphenated. 

26.3.16 Criterion/Criteria 
“Criterion” is singular; “criteria” is plural. 

Example

26.3.17 Cross-Reference 

: Set the file criteria by right-clicking each criterion individually and 
selecting the option that best describes your file. 

“Cross-reference” is one word, hyphenated. 

26.3.18 Cursor 
The cursor, which appears as a rectangle or a blinking or solid line, indicates when a 
response is needed and the position where it needs to be typed. A cursor can appear in 
both roll-and-scroll and GUI applications.  

Do not use “pointer” as a synonym for “cursor.” Refer also to Pointer. 

26.4 D 

26.4.1 Data (Noun) 
The word “data” is used as both the plural and singular of the word “datum,” in 
accordance with accepted usage in the software/computer industry and the argument 
that a datum (a piece of data) is an abstract and impractical measurement of 
information.  

Except in some academic contexts, “data” is generally treated as a singular noun, 
even though it refers to multiple pieces of information. In RPMS documentation, use 
“data” as a singular noun. 

Example: Data is stored on tape. 

Example: The data is up to date. 
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26.4.2 Database 
“Database” is one word with no space or hyphen. 

A database is a collection of related information organized in such a way that the 
information can be easily accessed, updated, and managed. Databases are composed 
of fields, records, and files:  

• Each individual piece of data is stored in a field. 

• A collection of fields containing data makes up a record. 

• A database file contains a collection of records, each with data in the same 
collection of fields. 

26.4.3 Database Fields 
A field in a database contains an individual piece of data of a specified data type. A 
collection of fields containing related pieces of data constitute a database record; the 
fields in a record generally contain data of several different data types. Refer also to 
Fields. 

RPMS applications use database fields containing nine different data types. Each of 
the following database field types is defined elsewhere in this section:  

• Computed field 

• Date field 

• Free Text field 

• Numeric field 

• Pointer to Files field 

• Set of Codes field 

• Time field 

• Word Processing field 

26.4.4 Database Files 
(RPMS) 

Database files are a collection of records that store related information (e.g., the 
RPMS Patient File). 

26.4.5 Data Set 
“Data set” is two words with no hyphen. 
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26.4.6 Date Field 
(RPMS) 

The Date field accepts only a predefined set of date formats. 

26.4.7 Date Range 
A date range should not be referred to as “a starting and ending date range.” The 
starting and ending elements are intrinsic to the concept of a “range,” so using the 
term “date range” is sufficient.  

If the starting and ending date elements are important enough to mention, use the 
phrase “starting and ending dates” or “starting date” and “ending date” and leave out 
the word “range.” 

Problem: The user will be prompted for a starting and ending date range. 

Solution: You will be prompted for a date range. 

Solution

26.4.8 Delete 

: You will be prompted for starting and ending dates. 

“Delete” means to remove an item that you cannot restore.  

Do not use “remove” to describe deleting an item that you cannot restore. 

26.4.9 Desire 
The word “desire” is generally not appropriate for technical documentation. Use 
“want” instead, or rewrite the sentence. (However, the phrase “the desired outcome” 
is an acceptable use of the word “desire.”) 

26.4.10 Desktop 
“Desktop” is one word with no hyphen. It refers to the background on the computer 
screen where the windows and icons are displayed. 

26.4.11 Desktop Menu 
The desktop menu is a list of choices displayed when the user right-clicks an open 
space on the desktop. 
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26.4.12 Directory 
A directory is a type of file used to organize other files into a hierarchical structure. 
Use the term “directory” only when referring to the structure of the file system. Refer 
also to Folder. 

26.4.13 Display 
(GUI only)  

Use “display” to describe opening an item within a window or on the desktop that 
remains visible until the user explicitly chooses to close the item. 

Example: On the Format menu, select Font to display the Edit Font dialog box. 

Note: “Display” should never be used as an intransitive verb. It must always have an 
object. 

Problem: The Edit Font dialog box displays. 

Solution: Selecting Font on the Format menu displays the Edit Font

26.4.14 Double-Click (Verb) 

 dialog box. 

(GUI only) 

“Double-click” means to press and release the left mouse button on an item twice in 
rapid succession. (Refer also to Click, Right-Click) 

Hyphenate “double-click” when used as a verb. Do not use the word “on” with 
“double-click.” 

Example

26.4.15 Drag 

: Double-click the name of the file you want to open. 

(GUI only)  

“Drag” means to click a mouse button on an object, hold the mouse button, and move 
the mouse to move the object or cursor. 

26.4.16 Drop-Down List Box 
(GUI only) 

In user instructions, generally use only “list” or “box” to describe this control, 
whichever is clearer, and instruct the user to “click” or “select” a list item.  
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Do not use the words “drop-down” unless absolutely necessary to distinguish a 
specific control. Hyphenate if used. 

Definition:

26.5 E 

 A closed version of a list box with an arrow next to it. Clicking the arrow 
opens the list and displays the items it contains. After the user selects an item from 
the list, the list box collapses back to a box displaying the selected item. 

26.5.1 Effect 
“Effect” is generally used as a noun. Refer also to Affect. 

Example

26.5.2 E-Mail 

: One effect of changing weather is aching sinuses. 

“E-mail” is hyphenated and does not take a capital letter unless the word occurs at the 
beginning of a sentence. 

26.5.3 Empty 
When no information is present in a field, refer to the field as “blank.” Do not use 
“empty” to refer to a field. 

26.5.4 End User (Noun) 
“End user” is two words. Do not hyphenate unless used as an adjective. 

26.5.5 Enter (Verb) 
Do not use “enter” when instructing the user to type specific information into a 
specific field. Use the word “type” instead.  

Use “enter” when referring to higher-level or general functions such as data entry. 

Example: Use the Patient Registration Menu option to enter patient data into the 
system. 

Example: To add a client, type A in the Patient field. 

Example: Type the patient’s full name at the “Select Patient Name” prompt. 
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26.5.6 Expand 
(GUI only)  

Opening a closed item in a tree structure is referred to as “expanding” the item. Items 
in tree structures are typically expanded by double-clicking the item or by clicking 
the plus sign (+) or arrow icon beside the item. 

Example

26.6 F 

: To expand a menu in Outline view, double-click the menu name or click 
the plus sign (+) next to the menu name. 

26.6.1 Fewer vs. Less 
Use “fewer” when referring to specific numbers and measurements.  

Use “less” when referring to general amounts. 

Problem: If a customer orders less than 10 CDs... 

Solution: If a customer orders fewer than 10 CDs but more than 5, the customer 
receives a free CD. 

Solution

26.6.2 Field 

: It takes less time to fill orders when your company uses our application. 

Definition:

In user instructions, do not use the word “field” to refer to roll-and-scroll prompts or 
GUI text boxes or other controls. 

 A field is a location in the interface where users type information to be 
added to a database or to search the database. Refer also to Database Fields.  

(Roll-and-scroll)  

In a roll-and-scroll application, fields on a screen serve the same function as blanks 
on a form. Each field is associated with a prompt requesting a specific type of data. 

In roll-and-scroll instructions, instruct the user to type the required information at the 
prompt. Section 20.3 contains detailed information. 

(GUI)  

In a GUI application, dialog boxes and other onscreen forms display fields in the 
form of text boxes and other controls where the user types or selects specific data. 
Each field has a label describing the required data. 
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In GUI instructions, use instructions appropriate to the specific type of control (text 
box, list box, etc.). Section 20.4 contains detailed information. 

26.6.3 FileMan 
“FileMan” is short for “File Manager.” FileMan is a VA-based utility that works 
behind the scene for most RPMS packages.  

Do not use “File Manager,” “fileman,” or “Fileman” as synonyms. 

26.6.4 Folder 
(GUI only)  

A folder is a representation of a directory in a graphical interface.  

Use the term “folder” to describe folder icons that represent directories or to describe 
navigation in a Windows Explorer window. Refer also to Directory. 

26.6.5 Follow Up 
The noun form, “follow-up,” is two words with a hyphen. 

Example: This visit was a follow-up after the patient was discharged. 

The adjectival form, “follow-up,” is two words with a hyphen. 

Example:

The verb form, “follow up,” is two words without a hyphen. 

 Record the follow-up visit under the patient’s name. 

Example:

26.6.6 Free Text Field 

 Be sure to follow up on this action item. 

(RPMS) 

The Free Text field accepts numbers, letters, and most of the symbols on the 
keyboard. Restrictions may apply to the number of characters that can be entered. 

“Free Text” is two words, capitalized, with no hyphen when used as the title of a field 
type.   

Example: The Moved to/Tx Elswhere

When describing the type of information a user should enter in a Free Text field, use 
“text” instead of “free text.” 

 field is a Free Text field. Type the name of 
the community where the patient has moved or transferred. 
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Problem: Add free text to indicate the community where the patient has moved or 
transferred. 

Solution:

26.6.7 From…To 

 Add text to indicate the community where the patient has moved or 
transferred. 

Use only two examples with “from” and “to.” 

Problem: Staff members from doctor to nurse to check-in clerk can easily navigate 
this system. 

Solution

26.7 H 

: Staff members of all experience levels, from doctor to check-in clerk, can 
easily navigate this system. 

26.7.1 Hardcopy vs. Hard Copy 
“Hard copy” is two words. It is hyphenated only when used as an adjective. 

26.7.2 Hardware 
Use “hardware” to refer to the machines and physical components linked to a 
computer. 

26.7.3 Healthcare 
“Healthcare” is one word. 

26.7.4 Hit (Verb) 
Do not use the word “hit.” Use “press” instead of “hit” or “strike.” 

Problem: Hit the Enter key. 

Solution

26.7.5 Home Page 

: Press the Enter key. 

“Home page” is two words and is not capitalized unless it is used at the beginning of 
a sentence or in a heading. 
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26.8 I 

26.8.1 Impact 
Do not use “impact” as a verb. Use “affect” instead. 

Problem: This software change could impact your check-in process. 

Solution

26.8.2 Includes  

: This software change could affect your check-in process. 

Use “includes” instead of “contains.” 

26.8.3 Internet 
The Internet is a global association of networks and computers that share information. 
“Internet” is a proper noun and is capitalized. 

26.8.4 Invoke 
Use “open” or “start” instead of “invoke.” 

Problem: Invoke the screen saver by pressing the Esc key. 

Solution

26.8.5 Irregardless 

: Start the screen saver by pressing the Esc key. 

Do not use “irregardless.” Use “regardless” instead.  

While “irregardless” is, in fact, a word, it is not commonly accepted usage and is not 
appropriate in technical documentation. 

26.9 K 

26.9.1 Keyboard Shortcut 
A keyboard shortcut is an action or sequence of actions performed using one or more 
keystrokes that would otherwise require a mouse or other pointing device. A 
keyboard shortcut provides a quicker and more convenient way to perform an action 
than using a mouse to perform the same action.  

Do not use “short-cut,” “shortcut,” “short cut,” “shortcut key,” or “keyboard 
accelerator” as synonyms. 



OIT Standards and Conventions v2.0 

Documentation Style Guide Usage and Terminology 
November 2010 

92 

26.10 L 

26.10.1 Launch 
Avoid using “launch.” Use “start” or “open” when appropriate. 

Problem: Launch the application by clicking the new desktop icon. 

Solution

26.10.2 Left Side 

: Start the application by clicking the new desktop icon. 

Use this term to refer to the left side of an item. Do not use “left-hand side.” 

26.10.3 Left-Click (Verb) 
(GUI only) 

“Left-click” is hyphenated.  

Use this term only

26.10.4 Left Mouse Button 

 to avoid ambiguity when describing an action that could also 
involve a middle-click or a right-click. Use “click” when the user will only be left-
clicking during the procedure.  

(GUI only)  

The left mouse button is the button under the index finger of the right hand on a 
mouse configured for right-hand use. 

26.10.5 List Box 
(GUI only) 

A list box is a box in a GUI application containing a list of items the user can select. 
The user cannot type a new selection in a list box. Refer also to Drop-Down List Box. 

In user instructions, generally use only “list” or “box” to describe this control, 
whichever is clearer, and instruct the user to “click” or “select” a list item. 

Example: In the Wallpaper list, click the background wallpaper of your choice. 
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26.11 M 

26.11.1 MailMan 
Short for Mail Manager. MailMan is a VA-based utility that facilitates messaging for 
a number of RPMS packages. Do not use “Mail Manager,” “mailman,” or “Mailman” 
as synonyms. 

26.11.2 Main Window 
Do not use “main window” unless referring to the process of creating a help file 
through RoboHelp. 

26.11.3 May (Auxiliary Verb) 
“May” implies permission. Use “can” instead, unless actually discussing permissions 
that the user has. 

26.11.4 Manual (User Manual, Technical Manual) 
When referring to internal manuals (user manuals, technical manuals, etc.), do not use 
any capitalization or possessives. If you are referring to manuals created by other 
companies that contain the word “manual” in their title, follow the rules for referring 
to titles. 

Problem: Refer to the User’s Manual for more information on this topic. 

Solution: Refer to the user manual for more information on this topic. 

Solution: Refer to the Microsoft Word Handbook and User Manual

26.11.5 Menu 

 for more 
information on this topic. 

A “menu” is a list of options that can be selected at a specific point or location in an 
application. 

(Roll-and-scroll) 

Example:

(GUI) 

 To choose a specific task or option, select a menu item from the list by 
typing the established abbreviation (mnemonic) or synonym at the prompt. 

Example: To choose a specific task or option, click a menu name to display a list of 
options, and then click the option you want to choose. 



OIT Standards and Conventions v2.0 

Documentation Style Guide Usage and Terminology 
November 2010 

94 

26.11.6 Middle-Click 
(GUI only)  

“Middle-click” means to press and release the middle mouse button on an item once. 
Do not use the word “on” with “middle-click.’ 

26.11.7 Middle Mouse Button 
(GUI only)  

The middle mouse button is the button under the second finger of the right hand in a 
mouse configured for right-hand use. 

26.11.8 Modify vs. Configure 
“Modification” is typically a small-scale activity. By contrast, “configuring” is a 
larger-scale activity. For example, you usually use the term “modification” to 
describe changing a specific characteristic or setting. Refer also to Configure. 

Example: Modify the background color value through the Properties dialog box. 

Example

26.11.9 Multi (prefix) 

: To configure your desktop, right-click an open space on the desktop. 

The prefix “multi” does not take a hyphen. See The Chicago Manual of Style (15th 
Edition) for rules and exceptions. 

Problem: multi-media, multi-tasking, multi-user 

Solution

26.12 N 

: multimedia, multitasking, multiuser 

26.12.1 Numeric Field 
(RPMS) 

The Numeric field accepts only numbers. Restrictions may apply to the number of 
characters that can be entered. 
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26.13 O 

26.13.1 Obvious, Obviously 
Words like “simply,” “obviously,” and “clearly” can seem condescending in some 
contexts. It’s important to pay attention to the tone of the document and use those 
words appropriately. 

26.13.2 Offsite/Off-Site 
Use “offsite” as one word with no hyphen. 

26.13.3 Onsite/On-Site 
Use “onsite” as one word with no hyphen. 

26.13.4 Online/On-Line 
Use “online” as one word with no hyphen. 

26.13.5 Onscreen/On-Screen 
Use “onscreen” as one word with no hyphen. 

26.13.6 Open 
(GUI only) 

Use “open” to describe opening a user interface component within a window or on 
the desktop that remains visible until the user explicitly chooses to close the item. 

Example: On the Format menu, select Font to open the Edit Font dialog box. 

Note: In general, “open” should not be used as an intransitive verb. It should 
generally have an object. 

Problem: On the Format menu, select Font. The Edit Font dialog box opens. 

Solution: On the Format menu, select Font to open the Edit Font

26.13.7 Option Button 

 dialog box. 

(GUI only) 

“Option button” is two words with no hyphen. The option button is sometimes called 
a “radio button,” but use “option button” in OIT documentation. 
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In user instructions, use “select” or “click” with the name of the option to describe the 
action of selecting an option button. Do not use the words “button” or “option button” 
with the name of the option. 

Definition: A round button used to select one of a group of mutually exclusive 
options (only one button in the group can be selected). The selected option button has 
a filled circle inside it. In some systems, option buttons can be styled to look like 
check boxes. 

Problem: Click the Portrait button. 

Problem: Click the Portrait radio button. 

Solution: Click Portrait. 

Problem: Select the Portrait radio button. 

Solution: Select Portrait

26.14 P 

. 

26.14.1 Permission 
A “permission” is a setting assigned to a file or directory that determines which users 
are allowed to read, write, and/or execute its contents. 

26.14.2 Pick (Verb) 
Do not use the word “pick.” Use “choose” or “select” to describe selecting menu 
options. 

Problem: Pick the option you need from the menu. 

Solution

26.14.3 Plug-In 

: Select the option you need on the menu. 

(GUI only)  

A “plug-in” is a supplementary program that can be added to an application to 
enhance the application’s functionality.  

Do not use “plugin” or “plug in.” 
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26.14.4 Point To 
(GUI only)  

“Point to” refers to positioning the pointer over a particular object or location without 
clicking a mouse button. Use “point to” instead of “point at” or “hover.” 

Example: On the Insert menu, point to Reference and then click Caption

26.14.5 Pointer 

. 

(GUI only)  

A “pointer” is a small arrow or other symbol on the screen that is moved with a 
mouse or other pointing device. A pointer can only appear in a GUI application.  

Do not use “cursor” as a synonym for “pointer.” If there is any ambiguity about what 
the term “pointer” refers to (for example, in developer documentation that also refers 
to pointer variables), use “mouse pointer.” Refer also to Cursor 

26.14.6 Pointer, Pointer to Files Field 
(RPMS) 

A Pointer to Files field in an RPMS database is a field that directs the application to 
another file for information. This type of field is often referred to simply as “a 
pointer.” 

26.14.7 Policyholder 
“Policyholder” is one word with no hyphen. 

26.14.8 Post (Prefix) 
The prefix “post” does not take a hyphen. See The Chicago Manual of Style (15th 
Edition) 

26.14.9 Pre (Prefix) 

for rules and exceptions. 

The prefix “pre” does not take a hyphen. See The Chicago Manual of Style (15th 
Edition for rules and exceptions. 

Problem: pre-defined 

Solution

26.14.10 Press (Verb) 

: predefined 

Use “press” for keyboard actions. Do not use “strike” or “hit.”  
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Use “click” for mouse actions in a GUI. 

Example: Press Enter to continue. 

Example: Click Apply

26.14.11 Printout (Noun) 

. 

As a noun, “printout” is one word with no hyphen. 

Do not use “print out” (two words) as a verb. Always use the single word “print” 
instead. 

26.14.12 Printset (Noun) 
“Printset” is one word with no hyphen. 

26.14.13 Privileges 
Privileges are a set of special permissions granted to a user to perform various 
operations on a system. 

26.14.14 Prompt 
(Roll-and-scroll) 

The prompt is an instruction displayed on the screen of a roll-and-scroll application 
specifying the type of information required by the application to continue with the 
current task. 

26.14.15 Pull-Down Menu 
Do not use “pull-down menu.” Use “menu” instead. (All menus are pull-down menus 
unless they're pop-up menus.) Refer also to Drop-Down List. 

26.15 Q  

26.15.1 QMan 
Short for Query Manager, QMan is a VA-based utility that works behind the scene 
for most RPMS packages.  

Do not use “Query Manager,” “qman,” or “Qman” as synonyms. 
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26.16 R 

26.16.1 Re (Prefix) 
The prefix “re” does not take a hyphen. See The Chicago Manual of Style (15th 
Edition) 

26.16.2 Record(s) 

for rules and exceptions. 

(RPMS) 

A record consists of a group of database fields. All records have names, such as 
“Patient Name.” In this case, all data associated with the name of a specific patient is 
located in the same record. 

26.16.3 Remove 
(GUI only)  

Use “remove” to describe removing an item that can be restored.  

Do not use “delete” to describe removing an item that can be restored. 

26.16.4 Right-Click 
(GUI only) 

“Right-click is two words and is always hyphenated, and means to press and release 
the right mouse button once on an item.  

Use “right-click” to describe the action of selecting a control or item in a window 
with the right mouse button. Do not use the word “on” with “right-click.” Refer also 
to Click. 

Example:

26.16.5 Right-Click Menu 

 Right-click the selected item to display the context menu. 

Do not use “right-click menu.” Use “context menu” instead. 
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26.16.6 Right Mouse Button 
(GUI only)  

The right mouse button is the button under the third finger of the right hand in a 
mouse configured for right-hand use. 

26.16.7 Right Side 
Use this term to refer to the right side of an item. Do not use “right-hand side.” 

26.16.8 Run 
Use “run” to describe executing a program, script, application, or report from the 
command line. 

Do not use “run” to describe opening an application from a desktop icon or from the 
Start menu. Use “start” or “open” instead. 

26.16.9 Run Time 
The noun form, “run time,” is two words without a hyphen.  

Example

The adjectival form, “run-time,” is two words with a hyphen. 

: The system will calculate the run time for you. 

Example

(Note: some software components are called “runtime” components or have the word 
“runtime” in their names. When discussing one of these components, check the 
correct spelling of the specific product.) 

: Type the run-time calculation at the “Total Time” prompt. 

26.17 S 

26.17.1 Screen 
(GUI)  

Use “screen” only to describe the physical panel on the front of the monitor. Always 
use “window” to describe a part of the GUI interface. 

(Roll-and-scroll)  

Use “screen” when referring to the window in which an RPMS package is running, 
because many users are still working with terminals that do not use Windows-style 
graphical windows. 
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26.17.2 Screen Capture 
Use “screen capture” to refer to a graphic image of an application window, a portion 
of a desktop, or an entire desktop. 

Do not use “screen shot,” “screen-shot,” “screenshot,” or “screen grab.” 

26.17.3 Scroll Bar 
“Scroll bar” is two words with no hyphen. 

26.17.4 Select 
(GUI only)  

Use “select” to describe marking the object on which an action is to be performed, 
such as text, one or more desktop icons, a menu, etc.  

Selected objects usually appear highlighted. Refer to the item that is selected as the 
“selection,” “selected text,” “selected menu,” etc. 

Do not use “choose” or “highlight” in this context.  

26.17.5 Selected/Unselected 
(GUI only)  

Use “selected” or “unselected” to describe the on or off state of a binary choice in a 
dialog box, such as a check box or option button (Refer also to Check Box, Option 
Button). 

26.17.6 Set of Codes Field 
(RPMS) 

The Set of Codes field usually accepts one or two characters, and is often used when 
Yes/No responses are required. 

26.17.7 Setup, Set Up 
The noun form, “setup,” is one word. 

Example:

The verb form, “set up,” is two words with no hyphen. 

 The setup is complete. 

Example: We will set up the email servers after lunch. 
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The adjectival form, “setup,” is one word. 

Example: 

The hyphenated word, “set-up,” is not used. 

The setup schedule was attached to my last email. 

26.17.8 Shortcut Key 
Do not use “shortcut key.” Use “keyboard shortcut” instead.  

26.17.9 Show 
Do not use “show” in the following ways (refer also to Appears, Display, Open): 

Problem: Click the Open button. The Open File dialog box shows. 

Solution: Click the Open button to display the Open File dialog box. 

Problem: The Patients pane shows the patients registered at the site. 

Solution: A list of patients registered at the site is displayed in the Patients pane. 

Solution: The Patients pane displays a list of patients registered at the site. 

Solution: The Patients

26.17.10 Simple, Simply 

 pane contains a list of patients registered at the site. 

Words like “simply,” “obviously,” and “clearly” can seem condescending in some 
contexts. It’s important to pay attention to the tone of the document and use these 
words appropriately.  

26.17.11 Single-Click 
Do not use “single-click.” Use “click” instead. Do not specify the number of clicks 
unless instructing the user to perform a double-click or a triple-click. 

26.17.12 Software 
“Software” refers to applications that allow users to interact with computer 
components (hardware). A software program or application is a set of instructions 
that control what is displayed on the screen, how information is entered, and what the 
computer does with the information or instructions that are entered. 

26.17.13 Stand-Alone 
“Stand-alone” is hyphenated when used as an adjective. It should not be used as a 
noun unless quoting documentation for third-party products. 
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26.17.14 Startup, Start-Up 
The noun form, “startup,” is one word. 

Example:

The adjectival form, “startup,” is one word. 

 The configuration file is read at startup. 

Example:

The hyphenated word “start-up” is not used. 

 The names are in the startup file. 

Do not use “start up” as a verb. Use “start” as the verb form instead. 

Problem: Start up the program by double-clicking the desktop icon. 

Solution:

26.17.15 Sub (Prefix) 

 Start the program by double-clicking the desktop icon. 

The prefix “sub” does not take a hyphen. See The Chicago Manual of Style (15th 
Edition) for rules and exceptions. (Note: avoid “sub-submenu” unless quoting 
documentation for third-party products.) 

Examples

26.17.16 Sync 

: Submenu, subfile, subrecord 

“Sync” is a common abbreviation for “synchronize.” Use “sync” instead of “synch.” 

26.17.17 System Administrator 
A “system administrator” is a user with root privileges on a UNIX system.  

This term may have a slightly different meaning to IHS users because many of the 
RPMS programs are referred to as system; therefore, the owners or managers of a 
particular package could also be referred to as system administrators. When using this 
term, be sure to define it in the glossary or the orientation section of the manual.  

Avoid using “superuser” or “root” as synonyms. 

26.18 T 

26.18.1 TaskMan 
Short for Task Manager, TaskMan is a VA-based utility that manages queues on 
RPMS systems. Do not use “Task Manager,” “taskman,” or “Taskman” as synonyms. 
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26.18.2 Their 
Do not use “their” as a gender-neutral singular pronoun. Instead, rewrite the sentence 
to make it plural or so that it does not require a pronoun. “His or hers” may also be 
used to avoid the use of “their,” but use it sparingly. Refer to Section 25.4 for more 
information on the use of gender in technical documentation. 

Problem: When the user looks at their screen, they crash the system. 

Solution: Look at your screen to crash the system. 

Solution

26.18.3 Time Field 

: When users look at their screens, they crash the system. 

(RPMS) 

The Time field accepts only a predefined set of time formats. 

26.18.4 Toolbar 
(GUI only) 

“Toolbar” is one word with no hyphen. 

26.18.5 Triple-Click 
(GUI only)  

Use “triple-click” to describe the action of pressing and releasing the left mouse 
button on an item three times in rapid succession. 

26.18.6 Type 
Use “type” instead of “enter.” Do not use “type in,” “type out,” or any other variation 
on the word “type.” 

Problem: Enter your name to start the program. 

Problem: Type in your name to start the program. 

Solution: Type your name to start the program. 
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26.19 U 

26.19.1 UNIX 
UNIX is a multiuser, multitasking operating system. “UNIX” is a registered 
trademark of the Open Group.  

The Open Group spells “UNIX” in all uppercase, which is the industry standard. Do 
not use “Unix” or any other nonstandard term unless directly quoting an (inaccurate) 
interface or other documentation. 

26.19.2 Utilize 
Do not use the word “utilize.” Use “use” instead. 

26.19.3 User Name 
“User name” is two words with no capitalization unless used at the beginning of a 
sentence or in a heading. 

Example: At the “User” prompt, type your user name. 

Exception: If the roll-and-scroll or GUI interface shows the term as one word, use 
one word when directly describing the interface. 

Example: Type your user name in the Username

26.20 V 

 box. 

26.20.1 Variable Pointer File Field 
(RPMS) 

The Variable Pointer File field performs like the Pointer to File field, with the 
exception that this field can accept a value from one or more files. 

26.21 W 

26.21.1 Web (Noun) 
When “web” is used as a noun to refer to the World Wide Web, it is initial capped 
(i.e., “Web,” a proper noun).  
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When “Web” is used as an adjective, it is capitalized and appears as a separate word 
as in the following examples: 

• Web address 

• Web browser 

• Web page 

• Web site 

Exceptions: 

• web-centric 

The following words are recognized as exceptions to this rule: 

• webcam 

• webcast 

• webmaster 

• webzine 

26.21.2 Web Site 
A “Web site” is a location on the World Wide Web.  

“Web site” is two words. The word “Web” is capitalized. 

Problem: Download the patch from our website. 

Problem: Download the patch from our web site. 

Problem: Download the patch from our Website. 

Problem: Download the patch from our Web Site. 

Solution

26.21.3 Window 

: Download the patch from our Web site. 

(GUI only)  

Always use “window” to describe a part of the GUI interface. Use “screen” only to 
describe the physical panel on the front of the monitor. 

(Roll-and-scroll)  

Use “screen” when referring to the window in which an RPMS package is running, 
because many users are still working with terminals that do not use Windows-style 
graphical windows. 
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26.21.4 Word Processing Field 
(RPMS) 

The Word Processing field allows the user to write, edit, and format text for letters, 
MailMan messages, etc. 

26.21.5 Workaround 
“Workaround” is one word with no hyphen. This word may sound like slang to the 
user, so use it sparingly and with the appropriate audience. 

26.21.6 Workflow 
“Workflow” is one word with no hyphen. 

26.21.7 World Wide Web 
The “World Wide Web” is a system of Internet servers that supports linked HTML 
documents, where clicking on links in HTML documents displays other documents 
on the World Wide Web.  

“World Wide Web” is a proper noun; all three words are capitalized. “World Wide 
Web” can be shortened to “Web” when clearly referring to the World Wide Web 
(notice the capital W in “Web”). For most users, this term is also interchangeable 
with “Internet.” Refer also to Web. 
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27.0. References and Sources 

27.1 Computer-Related Content 
The following sources were used for computer-related spelling and usage content: 

• Microsoft Manual of Style for Technical Publications, 3rd

• 

 Edition 

http://www.Webopedia.com  

• http://www.m-w.com (Merriam Webster Online Dictionary).  

27.2 General Content  
A significant amount of content came from the following sources: 

• The Chicago Manual of Style, 15th

• Online style guide created by Scriptorium at 

 Edition 

http://www.scriptorium.com/Standards/ 

• The GNOME Documentation Project Style Guide at 
http://library.gnome.org/devel/gdp-style-guide/2.26/ 

27.3 IHS/RPMS Content 
Some of the IHS/RPMS-specific content came from Appendix F of the RPMS 
Programming Standards and Conventions.

http://www.webopedia.com/�
http://www.m-w.com/�
http://www.scriptorium.com/Standards/�
http://library.gnome.org/devel/gdp-style-guide/2.26/�
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Appendix A: RPMS Template Styles 

A.1 STYLE INDEX 
The following is a list of styles available in all RPMS templates and a brief 
description of each. 

Style Description 
Bdytxt1 The basic body text style used for all RPMS documents. It is 

indented .75 inches from the left, and includes 12 points of 
space after a hard return 

Bdytxt 1 LeadIn The same as bdytext1, but with only 6 points of space after a 
hard return. Use this style for text leading into a bulleted or 
numbered list. 

Bdytxt2 The basic body text style, but indented 1 inch from the left. 
Use this style for additional paragraphs that fall under a 
bulleted or numbered list. 

Bdytxt2 LeadIn The same as bdytext2, but with only 6 points of space after a 
hard return. Use this style for text leading into a bulleted or 
numbered list. 

Bdytxt3 The basic body text style, but indented 1 ¼ inches from the 
left. Use this style for additional paragraphs that fall under a 
bulleted or numbered list. 

Bdytxt4 The basic body text style, but indented 1 ½ inches from the 
left. Use this style for additional paragraphs that fall under a 
bulleted or numbered list. 

Block Text Use for quoted material more than 4 lines in length. 
Bold Use this style instead of pressing Ctrl-B or the “B” button on 

the toolbar. It will bold text without modifying the underlying 
style. 

BoldItalic Use this style instead of pressing Ctrl-B and Ctrl-I, or the “B” 
and “I” buttons on the toolbar. It will bold and italicize text 
without modifying the underlying style. 

Bullet1 Use for bulleted lists. Each is indented .75 inches from the 
left, and has a ¼ inch hanging indent with 6 points of space 
after a hard return. 

Bullet2 Use for the third series in a bulleted list. Each is indented .1 
inch from the left, and has a ¼ inch hanging indent with 6 
points of space after a hard return. 

Bullet3 Use for the fifth series in a bulleted list. Each is indented .1 ¼ 
inches from the left, and has a ¼ inch hanging indent with 6 
points of space after a hard return. 

Caption Use only to add figure captions to screen captures formatted 
as “Computer Output” in roll-and-scroll documentation. 
Otherwise, use the Insert Caption option in the context 
menu. 
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Style Description 
CaptionIndent Use only to add figure captions to screen captures formatted 

as “computer screen” in roll-and-scroll documentation. 
Otherwise, use the Insert Caption option in the context 
menu. 

CaptionWide Use only for figures too large to be formatted as “Picture.” 
Otherwise, use the Insert Caption option in the context 
menu. 

Computer Output Shades text, indents text from the left and right by .07 inches, 
formats text as Courier New, and adds 6 points of space 
above and below text. Use only for screen captures. 

Computer output Shades text, indents text from the left and right by .07 inches, 
formats text as 9 point Courier New, and adds 6 points of 
space above and below text. Use only for screen captures. 

Computer screen Shades text, indents text from the left by .08 inches, formats 
text as Courier New, and adds 6 points of space above and 
below text. Use only for screen captures. 

Contact_info Formats text as 11 point Arial in the style used for the Contact 
Information section. 

Contents Use only as the header for the Table of Contents. 
CoverInfo Use this style only to format the author and address 

information on the cover of an RPMS manual. 
Dash1 Use as the second series in a bulleted list. 
Dash 2 Use as the fourth series in a bulleted list. 
Dash3 Use as the sixth series in a bulleted list. 
Emphasis Use this style for emphasizing text in place of pressing Ctrl-I 

or clicking the “I” button on the toolbar. 
Footnote Reference Use this style to add a footnote. 
Footnote Text Footnotes will be formatted using this style. 
GlossTerm The style used for terms in a Glossary. Glossary definitions 

are formatted with the “bdytxt3” style. 
1.0 Heading 1 First-level heading for sections in the body of the document. 
1.1 Heading 2 Second-level heading for sections in the body of the 

document 
1.1.1 Heading 3 Third-level heading for sections in the body of the document 
1.1.1.1 Heading 4 Fourth-level heading for sections in the body of the document 
1.1.1.1.1 Heading 5 Fifth-level heading for sections in the body of the document 
Appendix A: Heading 6 This is a first-level heading for all appendixes.  
A.1 Heading 7 This is a second-level heading for all appendixes. 
A.1.1 Heading 8 This is a third-level heading for all appendixes. 
A.1.1.1 Heading 9 This is a fourth-level heading for all appendixes. 
Italic Use this style to italicize text instead of pressing Ctrl-I or 

clicking the “I” button on the toolbar. 
a. ListAlpha Use for the second series in a numbered list. Items are 

indented 1 inch, with 6 points of space after, and are 
automatically lettered in sequence. 
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Style Description 
1. ListNum Use for the first series in a numbered list. Items are indented 

.75 inches, with 10 points of space after, and are 
automatically numbered in sequence. 

Manual Type Use this style only to format the manual type information 
(Technical Manual, User Manual, etc.) on the cover of an 
RPMS manual. 

Menu Use to format the initial menu line in the section of a roll-and-
scroll manual. 

Month_year Use this style only to format the month and year information 
on the cover of an RPMS manual. 

Namespace Use this style only to format the namespace on the cover of 
an RPMS manual. 

Notes Important information can be highlighted using the Notes 
style. The text will display in a shaded box indented 1 inch 
from the right and left with “Notes” in bold. 

Number Use this style for a numbered list when you don’t want 
automatic numbering. Text is indented .75 inches with 6 
points of space after. You must type the number and press 
the Tab key to number items. 

NumberIndent Use this style for the second series in a numbered list when 
you don’t want automatic lettering. Text is indented 1 inch 
with 6 points of space after. You must type the letter and 
press Tab to letter items. 

Picture Format figures with this style to keep a figure and its caption 
on the same page. 

PictureIndent Indents figures 1 inch from the left to fall in line with text and 
to keep a figure and its caption on the same page. 

PictureWide Formats figures too wide to fall in line with text, and keeps a 
figure and its caption on the same page. 

Preface Use only as the header for the Preface. 
Program Use only to format the program information (“Resource and 

Patient Management System”) on the cover of an RPMS 
manual. 

Section Formats text as a first-level head without numbering or 
lettering. Use this style for sections such as Contact 
Information. 

Space Use to add 8 points of space where necessary. 
Subhead Formats text as a second-level head without numbering or 

lettering.  
TableEnd Use to add 8 points of space after a table. 
TableHeadCtr Formats the header row of a table. Text is 11 points, bolded 

and centered. 
TableHeadLeft Formats the header row of a table. Text is 11 points, bolded 

and left-justified. 
TableText Use this style for left-justified, 10-point text in a table. 
TableText_Centered Use this style for centered, 10-point text in a table. 
TableTextL Formats left-justified, 12-point text in a table. 
TableTextL_Centered Formats centered, 12-point text in a table. 
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Style Description 
TableTextM Use this style for left-justified, 11-point text in a table. 
TableTextM_Centered Formats centered, 11-point text in a table. 
Table Title Use this style for table captions. Unlike figure captions, table 

captions always precede a table.  
Tbdytxt Use this style for text in a table without indents. 
Tbdytxt2 Use this style for text in a table with a ¼-inch indent. 
tBullet1 Use to add a bulleted list to a table. 
Title Page Use only to format the application name information on the 

cover of an RPMS manual. 
tNumber Use to add a numbered list to a table. This style will not 

autonumber items.  
tNumberInd Use to add the second series in a numbered list to a table. 

This style does not autoletter items. 
TOC1, TOC2, TOC3 These are the styles used only in the Table of Contents. As 

the Table of Contents for RPMS manuals is autogenerated 
based on heading styles, you should not need to use or 
modify these styles. 

TP_Logo This style formats only the IHS and HHS logos on the cover 
of an RPMS manual. You should not need to use or modify 
these styles. 

Version Use only to format the version number (and patch number, if 
any) on the cover of an RPMS manual. 

Warning Similar to Notes, this style highlights important information in 
a box shaded yellow and indented 1 inch from the left.  
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